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Through the years of evolution of DXC Insurance RISKMASTER™, it has been realized that the
customers of this product have embraced — and now fully expect — Digital Insurance. And, because
customers are focused on digital modes of processing Claims, DXC Technology has, through its
vdrious previous releases metamorphosed and reengineered this product offering by embracing
contemporary & emerging digital technologies and forging partnerships with service providers, not just
to attract new customers but also to retain, nurture and service the existing ones.

With the release of DXC Insurance RISKMASTER™ v.19.1, DXC Technology takes yet another
significant leap towards the fruition of its vision to provide Digital Insurance.

As has been the trend at DXC, technological upgrades and inclusion of newer features are continuous
processes with Insurance RISKMASTER. In keeping with this trend, v.19.1 release of the application
introduces several New Features, addressing the specific business needs of the global user community,
and Enhancements to preexisting features, making the application more efficient & user friendly. The
inclusion of several Administration & Security related enhancements makes this release a unique one.
Besides these, several Customer Resolutions have also been provided in this release.

This Release Notes document captures the details of all-important New Features introduced in release
v.19.1. These include dedicated modules on Autosaving Enhanced Notes, Navigation, Address
Autocompletion using third-party APIs, Switching Databases & PowerViews, Electronic Remittances &
Subrogation.

Other important New Features encompass modules for Check Printing, Customizing Policy Validations,
Claims Desktop Integration and EDI Validations. Novel functionalities for Logging Rolled & Routed
Information, Tracking & Recording changes in Claim Type Review Information, AWW & PMI Calculations
and a module for accessing System Error Messages in real-time.

Third-party tech solution providers like SubroPro (by Amali Solutions Group), Viewpost (by Viewpost IP
Holdings, LLC) & Melissa Global Express Entry have been onboarded as trusted partners for providing
streamlined, intuitive & effective business solutions making Insurance RISKMASTER an unbeatable
package offering.

Besides a host of novelties introduced in Insurance RISKMASTER v.19.1, this release also boats of several
Improvements & Enhancements to its existing feature modules that accord greater agility and improved
usability to the application. The improved performance and user interface enhancements make this
release version nimbler, intuitive and bereft of distortions.

This release version also integrates several Administrative & Security related enhancements. Insurance
RISKMASTER Administrators and Technicians will now be able to Configure Multiple Email APls, Mask
Banking Information, Import IdP Information, Customize the PowerView Editor, generate Self-signed
Certificates, Clone Module Security Groups and last but not the least Configure & Control Predictive
Texts for the entire application.

Besides all of these, this Release Notes document also captures details of the Customer Resolutions.
Furthermore, to aid a fuller understanding of some New Features, their Video Demonstrations can be
directly accessed via links in this document. Alternatively, they can also be viewed on the

site.

To sum up, all New Features, Functional Upgrades, Feature Enhancements and Performance
Improvements not only engender greater versatility, maneuverability and control over the application, but
also address issues pertaining to privacy, information security and specific business needs of users across
regions, thus, benefiting the global customer community.

© 2019. DXC Technology Company. All rights reserved.
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New Features

This section of the Release Notes document describes all the New Features
that make DXC Insurance RISKMASTER™ v.19.1 more robust and flexible to
accommodate business scenarios to perform operations.

This section consists of detailed video demonstrations of New Features along
with descriptions of innovations introduced in this release.

Video Demonstration of Select New Features

Insurance RISKMASTER v.19.1 brings about several novelties in this release. Click on the images below to get
redirected to the Insurance RISKMASTER website for a fuller understanding of the corresponding New

Features.

Alternatively, the Help navigation on the primary menu bar of the Insurance RISKMASTER application (v.17.1
& onwards) can also be selected to access the video demo on this enhancement.

Autosaving Claim Enhanced Notes

B oxCochnology

Insurance RISKMASTER
Auto Saving Enhancent Note

Demo Video 1

Navigation with an Enhanced Right-hand Pane

D€ oxCochnology

Insurance RISKMASTER
Enhanced Right - Hand Pane

Demo Video 2

The functionality of the Autosaving Enhanced
Notes feature is self-explanatory. Now, the
module becomes more user friendly with the
removal of the need to save the Enhanced Notes
repeatedlu.

Navigation has been rendered easier with an
Enhanced Right-hand Pane. The right-hand pane
can be toggled between icon and accordion
views. This also accords screens with an
uncluttered feel across the application.

Address Autocomplete with Melissa &
RISKMASTER’s API*

pxq DXC.tachnology

Insurance RISKMASTER
Address Autocomplete with

Melissa & RISKMASTER’s API

Demo Video 3

The Address Autocomplete feature with Melissa
& RISKMASTER’s API ensures data accuracy with
auto filling verified addresses.

melissa

For information on
procuring this
feature.

Click Here *
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VN
g |


https://riskmaster.com/Login.aspx?ReturnUrl=%2fhomepage.aspx
https://rmahelp.csc-rmcl.com/Riskmasterhelp/
https://rmahelp.csc-rmcl.com/RiskmasterHelp/wp-content/uploads/2019/videos/auto_save_enhance_notes.mp4
https://rmahelp.csc-rmcl.com/RiskmasterHelp/wp-content/uploads/2019/videos/auto_save_enhance_notes.mp4
https://rmahelp.csc-rmcl.com/RiskmasterHelp/wp-content/uploads/2019/videos/Expand_and_collapse_feature.mp4
https://rmahelp.csc-rmcl.com/RiskmasterHelp/wp-content/uploads/2019/videos/automatic_address_verification.mp4
https://rmahelp.csc-rmcl.com/RiskmasterHelp/wp-content/uploads/2019/videos/automatic_address_verification.mp4
https://rmahelp.csc-rmcl.com/RiskmasterHelp/wp-content/uploads/2019/videos/auto_save_enhance_notes.mp4
https://rmahelp.csc-rmcl.com/RiskmasterHelp/wp-content/uploads/2019/videos/auto_save_enhance_notes.mp4
https://rmahelp.csc-rmcl.com/RiskmasterHelp/wp-content/uploads/2019/videos/Expand_and_collapse_feature.mp4
https://rmahelp.csc-rmcl.com/RiskmasterHelp/wp-content/uploads/2019/videos/automatic_address_verification.mp4
https://rmahelp.csc-rmcl.com/RiskmasterHelp/wp-content/uploads/2019/videos/automatic_address_verification.mp4
https://rmahelp.csc-rmcl.com/RiskmasterHelp/wp-content/uploads/2019/videos/auto_save_enhance_notes.mp4
https://rmahelp.csc-rmcl.com/RiskmasterHelp/wp-content/uploads/2019/videos/auto_save_enhance_notes.mp4
https://rmahelp.csc-rmcl.com/RiskmasterHelp/wp-content/uploads/2019/videos/Expand_and_collapse_feature.mp4
https://rmahelp.csc-rmcl.com/RiskmasterHelp/wp-content/uploads/2019/videos/automatic_address_verification.mp4
https://rmahelp.csc-rmcl.com/RiskmasterHelp/wp-content/uploads/2019/videos/automatic_address_verification.mp4
https://rmahelp.csc-rmcl.com/RiskmasterHelp/wp-content/uploads/2019/videos/auto_save_enhance_notes.mp4
https://rmahelp.csc-rmcl.com/RiskmasterHelp/wp-content/uploads/2019/videos/auto_save_enhance_notes.mp4
https://rmahelp.csc-rmcl.com/RiskmasterHelp/wp-content/uploads/2019/videos/auto_save_enhance_notes.mp4
https://rmahelp.csc-rmcl.com/RiskmasterHelp/wp-content/uploads/2019/videos/Expand_and_collapse_feature.mp4
https://rmahelp.csc-rmcl.com/RiskmasterHelp/wp-content/uploads/2019/videos/automatic_address_verification.mp4
https://rmahelp.csc-rmcl.com/RiskmasterHelp/wp-content/uploads/2019/videos/automatic_address_verification.mp4
https://rmahelp.csc-rmcl.com/RiskmasterHelp/wp-content/uploads/2019/videos/auto_save_enhance_notes.mp4
https://rmahelp.csc-rmcl.com/RiskmasterHelp/wp-content/uploads/2019/videos/auto_save_enhance_notes.mp4
https://rmahelp.csc-rmcl.com/RiskmasterHelp/wp-content/uploads/2019/videos/auto_save_enhance_notes.mp4
https://rmahelp.csc-rmcl.com/RiskmasterHelp/wp-content/uploads/2019/videos/Expand_and_collapse_feature.mp4
https://rmahelp.csc-rmcl.com/RiskmasterHelp/wp-content/uploads/2019/videos/automatic_address_verification.mp4
https://rmahelp.csc-rmcl.com/RiskmasterHelp/wp-content/uploads/2019/videos/automatic_address_verification.mp4
https://rmahelp.csc-rmcl.com/RiskmasterHelp/wp-content/uploads/2019/videos/auto_save_enhance_notes.mp4
https://rmahelp.csc-rmcl.com/RiskmasterHelp/wp-content/uploads/2019/videos/auto_save_enhance_notes.mp4
https://rmahelp.csc-rmcl.com/RiskmasterHelp/wp-content/uploads/2019/videos/Expand_and_collapse_feature.mp4
https://rmahelp.csc-rmcl.com/RiskmasterHelp/wp-content/uploads/2019/videos/automatic_address_verification.mp4
https://rmahelp.csc-rmcl.com/RiskmasterHelp/wp-content/uploads/2019/videos/automatic_address_verification.mp4
https://rmahelp.csc-rmcl.com/RiskmasterHelp/wp-content/uploads/2019/videos/auto_save_enhance_notes.mp4
https://rmahelp.csc-rmcl.com/RiskmasterHelp/wp-content/uploads/2019/videos/auto_save_enhance_notes.mp4
https://rmahelp.csc-rmcl.com/RiskmasterHelp/wp-content/uploads/2019/videos/Expand_and_collapse_feature.mp4
https://rmahelp.csc-rmcl.com/RiskmasterHelp/wp-content/uploads/2019/videos/automatic_address_verification.mp4
https://rmahelp.csc-rmcl.com/RiskmasterHelp/wp-content/uploads/2019/videos/automatic_address_verification.mp4
https://rmahelp.csc-rmcl.com/RiskmasterHelp/wp-content/uploads/2019/videos/auto_save_enhance_notes.mp4
https://rmahelp.csc-rmcl.com/RiskmasterHelp/wp-content/uploads/2019/videos/auto_save_enhance_notes.mp4
https://rmahelp.csc-rmcl.com/RiskmasterHelp/wp-content/uploads/2019/videos/Expand_and_collapse_feature.mp4
https://rmahelp.csc-rmcl.com/RiskmasterHelp/wp-content/uploads/2019/videos/automatic_address_verification.mp4
https://rmahelp.csc-rmcl.com/RiskmasterHelp/wp-content/uploads/2019/videos/automatic_address_verification.mp4
https://rmahelp.csc-rmcl.com/RiskmasterHelp/wp-content/uploads/2019/videos/auto_save_enhance_notes.mp4
https://rmahelp.csc-rmcl.com/RiskmasterHelp/wp-content/uploads/2019/videos/auto_save_enhance_notes.mp4
https://rmahelp.csc-rmcl.com/RiskmasterHelp/wp-content/uploads/2019/videos/Expand_and_collapse_feature.mp4
https://rmahelp.csc-rmcl.com/RiskmasterHelp/wp-content/uploads/2019/videos/automatic_address_verification.mp4
https://rmahelp.csc-rmcl.com/RiskmasterHelp/wp-content/uploads/2019/videos/automatic_address_verification.mp4
https://rmahelp.csc-rmcl.com/RiskmasterHelp/wp-content/uploads/2019/videos/auto_save_enhance_notes.mp4
https://rmahelp.csc-rmcl.com/RiskmasterHelp/wp-content/uploads/2019/videos/auto_save_enhance_notes.mp4
https://rmahelp.csc-rmcl.com/RiskmasterHelp/wp-content/uploads/2019/videos/Expand_and_collapse_feature.mp4
https://rmahelp.csc-rmcl.com/RiskmasterHelp/wp-content/uploads/2019/videos/Expand_and_collapse_feature.mp4
https://rmahelp.csc-rmcl.com/RiskmasterHelp/wp-content/uploads/2019/videos/Expand_and_collapse_feature.mp4
https://rmahelp.csc-rmcl.com/RiskmasterHelp/wp-content/uploads/2019/videos/automatic_address_verification.mp4
https://rmahelp.csc-rmcl.com/RiskmasterHelp/wp-content/uploads/2019/videos/automatic_address_verification.mp4
https://rmahelp.csc-rmcl.com/RiskmasterHelp/wp-content/uploads/2019/videos/auto_save_enhance_notes.mp4
https://rmahelp.csc-rmcl.com/RiskmasterHelp/wp-content/uploads/2019/videos/auto_save_enhance_notes.mp4
https://rmahelp.csc-rmcl.com/RiskmasterHelp/wp-content/uploads/2019/videos/Expand_and_collapse_feature.mp4
https://rmahelp.csc-rmcl.com/RiskmasterHelp/wp-content/uploads/2019/videos/automatic_address_verification.mp4
https://rmahelp.csc-rmcl.com/RiskmasterHelp/wp-content/uploads/2019/videos/automatic_address_verification.mp4
https://rmahelp.csc-rmcl.com/RiskmasterHelp/wp-content/uploads/2019/videos/auto_save_enhance_notes.mp4
https://rmahelp.csc-rmcl.com/RiskmasterHelp/wp-content/uploads/2019/videos/auto_save_enhance_notes.mp4
https://rmahelp.csc-rmcl.com/RiskmasterHelp/wp-content/uploads/2019/videos/Expand_and_collapse_feature.mp4
https://rmahelp.csc-rmcl.com/RiskmasterHelp/wp-content/uploads/2019/videos/automatic_address_verification.mp4
https://rmahelp.csc-rmcl.com/RiskmasterHelp/wp-content/uploads/2019/videos/automatic_address_verification.mp4
https://rmahelp.csc-rmcl.com/RiskmasterHelp/wp-content/uploads/2019/videos/auto_save_enhance_notes.mp4
https://rmahelp.csc-rmcl.com/RiskmasterHelp/wp-content/uploads/2019/videos/auto_save_enhance_notes.mp4
https://rmahelp.csc-rmcl.com/RiskmasterHelp/wp-content/uploads/2019/videos/Expand_and_collapse_feature.mp4
https://rmahelp.csc-rmcl.com/RiskmasterHelp/wp-content/uploads/2019/videos/automatic_address_verification.mp4
https://rmahelp.csc-rmcl.com/RiskmasterHelp/wp-content/uploads/2019/videos/automatic_address_verification.mp4
https://rmahelp.csc-rmcl.com/RiskmasterHelp/wp-content/uploads/2019/videos/automatic_address_verification.mp4
https://rmahelp.csc-rmcl.com/RiskmasterHelp/wp-content/uploads/2019/videos/auto_save_enhance_notes.mp4
https://rmahelp.csc-rmcl.com/RiskmasterHelp/wp-content/uploads/2019/videos/auto_save_enhance_notes.mp4
https://rmahelp.csc-rmcl.com/RiskmasterHelp/wp-content/uploads/2019/videos/Expand_and_collapse_feature.mp4
https://rmahelp.csc-rmcl.com/RiskmasterHelp/wp-content/uploads/2019/videos/automatic_address_verification.mp4
https://rmahelp.csc-rmcl.com/RiskmasterHelp/wp-content/uploads/2019/videos/automatic_address_verification.mp4
https://rmahelp.csc-rmcl.com/RiskmasterHelp/wp-content/uploads/2019/videos/automatic_address_verification.mp4
https://rmahelp.csc-rmcl.com/RiskmasterHelp/wp-content/uploads/2019/videos/auto_save_enhance_notes.mp4
https://rmahelp.csc-rmcl.com/RiskmasterHelp/wp-content/uploads/2019/videos/auto_save_enhance_notes.mp4
https://rmahelp.csc-rmcl.com/RiskmasterHelp/wp-content/uploads/2019/videos/Expand_and_collapse_feature.mp4
https://rmahelp.csc-rmcl.com/RiskmasterHelp/wp-content/uploads/2019/videos/automatic_address_verification.mp4
https://rmahelp.csc-rmcl.com/RiskmasterHelp/wp-content/uploads/2019/videos/automatic_address_verification.mp4
https://rmahelp.csc-rmcl.com/RiskmasterHelp/wp-content/uploads/2019/videos/auto_save_enhance_notes.mp4
https://rmahelp.csc-rmcl.com/RiskmasterHelp/wp-content/uploads/2019/videos/auto_save_enhance_notes.mp4
https://rmahelp.csc-rmcl.com/RiskmasterHelp/wp-content/uploads/2019/videos/Expand_and_collapse_feature.mp4
https://rmahelp.csc-rmcl.com/RiskmasterHelp/wp-content/uploads/2019/videos/automatic_address_verification.mp4
https://rmahelp.csc-rmcl.com/RiskmasterHelp/wp-content/uploads/2019/videos/automatic_address_verification.mp4
https://rmahelp.csc-rmcl.com/RiskmasterHelp/wp-content/uploads/2019/videos/auto_save_enhance_notes.mp4
https://rmahelp.csc-rmcl.com/RiskmasterHelp/wp-content/uploads/2019/videos/auto_save_enhance_notes.mp4
https://rmahelp.csc-rmcl.com/RiskmasterHelp/wp-content/uploads/2019/videos/Expand_and_collapse_feature.mp4
https://rmahelp.csc-rmcl.com/RiskmasterHelp/wp-content/uploads/2019/videos/automatic_address_verification.mp4
https://rmahelp.csc-rmcl.com/RiskmasterHelp/wp-content/uploads/2019/videos/automatic_address_verification.mp4
https://rmahelp.csc-rmcl.com/RiskmasterHelp/wp-content/uploads/2019/videos/auto_save_enhance_notes.mp4
https://rmahelp.csc-rmcl.com/RiskmasterHelp/wp-content/uploads/2019/videos/auto_save_enhance_notes.mp4
https://rmahelp.csc-rmcl.com/RiskmasterHelp/wp-content/uploads/2019/videos/Expand_and_collapse_feature.mp4
https://rmahelp.csc-rmcl.com/RiskmasterHelp/wp-content/uploads/2019/videos/automatic_address_verification.mp4
https://rmahelp.csc-rmcl.com/RiskmasterHelp/wp-content/uploads/2019/videos/automatic_address_verification.mp4
https://rmahelp.csc-rmcl.com/RiskmasterHelp/wp-content/uploads/2019/videos/auto_save_enhance_notes.mp4
https://rmahelp.csc-rmcl.com/RiskmasterHelp/wp-content/uploads/2019/videos/auto_save_enhance_notes.mp4
https://rmahelp.csc-rmcl.com/RiskmasterHelp/wp-content/uploads/2019/videos/Expand_and_collapse_feature.mp4
https://rmahelp.csc-rmcl.com/RiskmasterHelp/wp-content/uploads/2019/videos/automatic_address_verification.mp4
https://rmahelp.csc-rmcl.com/RiskmasterHelp/wp-content/uploads/2019/videos/automatic_address_verification.mp4
https://rmahelp.csc-rmcl.com/RiskmasterHelp/wp-content/uploads/2019/videos/auto_save_enhance_notes.mp4
https://rmahelp.csc-rmcl.com/RiskmasterHelp/wp-content/uploads/2019/videos/auto_save_enhance_notes.mp4
https://rmahelp.csc-rmcl.com/RiskmasterHelp/wp-content/uploads/2019/videos/Expand_and_collapse_feature.mp4
https://rmahelp.csc-rmcl.com/RiskmasterHelp/wp-content/uploads/2019/videos/automatic_address_verification.mp4
https://rmahelp.csc-rmcl.com/RiskmasterHelp/wp-content/uploads/2019/videos/automatic_address_verification.mp4
https://rmahelp.csc-rmcl.com/RiskmasterHelp/wp-content/uploads/2019/videos/auto_save_enhance_notes.mp4
https://rmahelp.csc-rmcl.com/RiskmasterHelp/wp-content/uploads/2019/videos/auto_save_enhance_notes.mp4
https://rmahelp.csc-rmcl.com/RiskmasterHelp/wp-content/uploads/2019/videos/Expand_and_collapse_feature.mp4
https://rmahelp.csc-rmcl.com/RiskmasterHelp/wp-content/uploads/2019/videos/automatic_address_verification.mp4
https://rmahelp.csc-rmcl.com/RiskmasterHelp/wp-content/uploads/2019/videos/automatic_address_verification.mp4
https://rmahelp.csc-rmcl.com/RiskmasterHelp/wp-content/uploads/2019/videos/auto_save_enhance_notes.mp4
https://rmahelp.csc-rmcl.com/RiskmasterHelp/wp-content/uploads/2019/videos/auto_save_enhance_notes.mp4
https://rmahelp.csc-rmcl.com/RiskmasterHelp/wp-content/uploads/2019/videos/Expand_and_collapse_feature.mp4
https://rmahelp.csc-rmcl.com/RiskmasterHelp/wp-content/uploads/2019/videos/automatic_address_verification.mp4
https://rmahelp.csc-rmcl.com/RiskmasterHelp/wp-content/uploads/2019/videos/automatic_address_verification.mp4
https://rmahelp.csc-rmcl.com/RiskmasterHelp/wp-content/uploads/2019/videos/auto_save_enhance_notes.mp4
https://rmahelp.csc-rmcl.com/RiskmasterHelp/wp-content/uploads/2019/videos/auto_save_enhance_notes.mp4
https://rmahelp.csc-rmcl.com/RiskmasterHelp/wp-content/uploads/2019/videos/Expand_and_collapse_feature.mp4
https://rmahelp.csc-rmcl.com/RiskmasterHelp/wp-content/uploads/2019/videos/automatic_address_verification.mp4
https://rmahelp.csc-rmcl.com/RiskmasterHelp/wp-content/uploads/2019/videos/automatic_address_verification.mp4
https://rmahelp.csc-rmcl.com/RiskmasterHelp/wp-content/uploads/2019/videos/auto_save_enhance_notes.mp4
https://rmahelp.csc-rmcl.com/RiskmasterHelp/wp-content/uploads/2019/videos/auto_save_enhance_notes.mp4
https://rmahelp.csc-rmcl.com/RiskmasterHelp/wp-content/uploads/2019/videos/Expand_and_collapse_feature.mp4
https://rmahelp.csc-rmcl.com/RiskmasterHelp/wp-content/uploads/2019/videos/automatic_address_verification.mp4
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To visit the Melissa website

Click Here
and explore more.

Integration of Insurance RISKMASTER & SubroPro

Insurance RISKMASTER brings a new & enhanced Subrogation process by integrating with SubroPro

(Powered by the Amali Solutions Group).

This integration enables posting of financial data from Insurance RISKMASTER to SubroPro for seamlessly
processing Subrogation on a Claim in both Online & Offline modes.

subrePRO

Click Here

For information on
* procuring this

feature.

Going forward, all Claims capable of Subrogation will be achieved via this integration.

All calculations pertaining to Subrogation will be processed in the SubroPro system. Once completed, the

processed data and the details of associated party (Entity) will be sent to the Insurance RISKMASTER system

via a Web APL. In turn, the Insurance RISKMASTER will create a Recovery Reserve over which a Collection is
done for the Subrogation amount sent by the SubroPro system.

- To visit the SubroPro
Click Here website and explore more.

Click Here

To read the Insurance
RISKMASTER & SubroPro
Initial Integration Guide.

Send Remittance Information to Viewpost

The application is now capable of processing
electronic remittances without revealing sensitive
banking related information.

The system sends across only those details which
are necessary for processing remittances. These
include:

» Payable Invoice ID
» Payable Invoice Number
» Payable Invoice Date

» Payable Invoice Paid Amount
» Payable Invoice Discount Amount

Note

After completion of the scheduled Print Check
Batch Utility for Viewpost, the information
shared during the remittance process is logged
in the Custom File generated in the JOB folder
of the TM JOB schedule folder.

To read a detailed document
on Insurance RISKMASTER &

Click Here
Viewpost integration.
For information on
Click Here * procuring this
feature.
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Ability to Switch Databases & PowerViews from any Zone

With this release, switching Databases/DSNs (Data Source Names) and PowerViews will become possible
from any Zone. In the previous versions, switching DSNs and PowerViews was possible via the Dashboard
screen only. Thus, this feature greatly improves the application’s user-friendliness.

A new ‘kebab’ buttonnhos been introduced on the primary menu bar in its right corner. [Fig. 1]

DXC Insurance RISKMASTER™ v.19.1 screen

dxc dxe
.:. DXC.technology . e

& Data Source Name

8 Power View Name

Funds [2019001942 * 1 * DU, VU]

> ™ I [+ 5o |wlS )0 B> ]o| o)) =]

[Fig. 1]

Another enhancement pertaining to Databases and PowerViews introduced in this release version of
Insurance RISKMASTER is the ability to set Database, Zone & PowerView as default for subsequent logins.

[Fig. 2]

DXC Insurance RISKMASTER™ v.19.1 screen

.I‘ DXC.technology

Login Name: DXC/DXC

Database Name

PowerView Name

Zone Name

Note:

>

Hovering the mouse over the kebab
button opens a small inline menu
displaying options to Change
Database/View & Logout.

This kebab button and its associated
inline menu options are available in the
primary menu bar of all Zones.

The Change Database/View option can
be selected to conveniently change the
Database or View or both for a user from
any Zone.

The Database, Zone and PowerView that
a user logs out of at the end of a session,
becomes the default Database and
PowerView for the user’s subsequent
login session.

[Fig. 2]

Detailed Summary Tree

Insurance RISKMASTER v.19.1 sports an improved Summary Tree accordion, accessed by selecting the Quick

Summary Slider present on the left pane of the Claims screen.

The Summary Tree now displays Payments and
Recoveries down to the Transaction Type level
providing a detailed overview of the Claim
including all its transactions in one place. [Fig. 3]

Summary Tree Data Display Sequence

Policy Name > Unit > Coverage > Loss Type >
Reserve Type > Claimant

© 2019. DXC Technology Company. All rights reserved.

Note:
>

»

Financial data available in the Financials
tab is displayed in the Summary Tree.
Based on the Funds records attached to
the Coverage, the financial data is split
to display total amounts spent for each
Transaction Type.

Reserve Transactions/Collections can be
created from the Summary Tree.
Scheduled Checks cannot be created
using the Summary Tree.
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DXC Insurance RISKMASTER™ v.19.1 Screen

-

D

[ Diaries

[~ Event Details

[ Follow Up

[~ Location Info

- OSHA Information
[~ Event Enhanced Notes
|- @General Claim Nr. GCAPVOMIG2019002100
[~ Claim Notes

Reserve Type Transaction Type

Type OutStanding Payments Printed Payments Allocated Payments Collections Incurred
[~ Claim Enhanced Notes

[ Diaries O Recovery ~ AUD 3672  AUD0.00 AUD 0.00 AUD0.00  AUD10.36 AUD 47.08
|- @Current Financials
- ©claimant Total AUD 36.72 AUD 0.00 AUD 0.00 AUD 0.00 AUD 10.36 -AUD 47.08
- OUnit Loss(s)
|- @Attached Policy
| @aPv 2001510 01
|- @vehicle Unit: 32426076543
I @Coverage: 101 Bodily Injury Split Lim |H
©QB1 Bodily Injury
OEXP Expense Payment
| RAHUL JAIN11'S reserve
QREC Recovery
|- RAHUL JAIN11'S reserve
Q1212 111
QEXP Expense Payment
’» |- RAHUL JAIN11's reserve
r ©Coverage: 114 Medical Payments 835
Ofoverage: 110 Property Damage Splif

[Fig. 3]

Quick Summary Performance Improvement

The loading time of the Quick Summary accordion on the Claims screen has been greatly reduced in this
release, thereby increasing the overall efficiency of the Claims module.

In previous versions of the application, the Quick Summary accordion loaded the entire Claim Summary
details in one go which was a time taking process.

Now, with the introduction of “Tree Nodes”, the details of the selected node load individually. The selection

of the o sign of the root node quickly expands [Fig. 3] to load its child nodes. Thus, the overall time needed
to load the Claim Summary is greatly reduced.

New Features & Enhancements in Claim Financials

The New Features & Enhancements listed below pertain to Claim Financials. All necessary descriptions have
been provided for each of them in this section.

» Ability to Mark Transactions Ready to Print
Enhancement in Stop Pay Transaction

Enhancement of Average Weekly Wage Calculations*
Implementation of Post-Mortem Interest Calculations*
Displaying Printed & Allocated Reserves

Improved Financials Screen

Payment Approval Performance Improvement
Currency Conversion and Date & Time Update

VVVVVYYVY

Ability to Mark Transactions Ready to Print

Addressing user’s need for viewing the complete financial impacts of transactions prior to printing checks,
Insurance RISKMASTER v.19.1 now accords users with the ability to mark transactions as Ready to Print.

Such users who print Checks using third-party routes instead of the Insurance RISKMASTER system will now
be able to mark transactions as Ready to Print and can freely use the application’s functionalities like:

© 2019. DXC Technology Company. All rights reserved.
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» Deductibles
» Non-Occ Payments

> Withholding
> GST
» Schedule Check

It is expected that the availability of the Ready to Print feature will encourage users to view the above
financial adjustments prior to printing checks through the system. As a result, it will give users a glimpse of
the monetary impacts that the mentioned financial adjustments will have after check printing.

Very importantly, transaction marked as “Ready to Print” end the possibility of making any changes

manually.

Prerequisite SMS Settings

Insurance RISKMASTER administrators can turn

on the Ready to Print option for selected users

by selecting the Allow Ready to Print checkbox
on the following path:

Security > Security Management System > Data
Sources > (select DSN) > Module Security Groups
> Administrator > RISKMASTER > Funds
Management > Transactions > Allow Ready to
Print (checkbox)

Prerequisite General System Parameter
Setting:

Insurance RISKMASTER administrators can select
the Prompt to Mark Transaction as Ready to
Print (checkbox) under the Funds Settings tab of
General System Parameter Setup to enable the
Ready to Print Confirmation popup for users.

If this setting is false, then users can manually
mark transactions as Ready to Print and no
automatic notification pop-up will come up.

Ready to Print checkbox

The “Ready to Print” checkbox is now available
on the following screens:

> Transaction
» Supervisory Approval
» Bulk Check Release

Transaction Screen — Changes & Impacts
Description:

» The Ready to Print checkbox remains
disabled along with the Void checkbox.

» The Ready to Print checkbox is enabled
when a Transaction has been created and
saved. [Fig. 4]

» Selecting the checkbox launches the

Ready to Print Confirmation popup. [Fig.

5]

© 2019. DXC Technology Company. All rights reserved.

Notes:

» No changes can be made to a
Transaction marked as Ready to Print.

» Transactions marked as Ready to Print
cannot be reverted or rolled back.

» For Transactions marked as Ready to
Print, the system will apply the
businesses which are used to get applied
at the time of printing the checks.

» At the time of Precheck Batch Register
system will automatically mark the
transactions as Ready to Print.

» This Ready to Print Confirmation popup
will appear automatically at the time of
saving the transaction when the Prompt
to Mark Transaction as Ready to Print
(checkbox) is selected under the Funds

Settings tab of General System Parameter

Setup.
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DXC Insurance RISKMASTER™ v.19.1 screen
Transaction (New) @ E

[+)B]a]e]mE] ]

B Transaction Info

Payment Cleared Void Collection
L] = = U]
Combined Payment?
_
Ready To Print Enclosure
= ]

[Fig. 4]

The Print Preview window opens when the Preview button on the Ready to Print Confirmation popup is
selected. [Fig. 5]

DXC Insurance RISKMASTER™ v.19.1 screen
Transaction (0016310) @ E

Ready To Print Confirmation

Are you sure want to mark this transaction as Ready To Print? Click ok to confirm, once
saved changes cannot be reversed.

[Fig. 5]

Selecting the Print Preview button on the Print Preview window opens the Checks and EOB Reports popup
[Fig. 6] from where a password protected Check bearing all relevant transaction details is generated.

[Fig.7].

Note:

» Selecting the Print Preview icon from the
Transaction screen toolbar will also
display the same values.

» Deductions are applied to Checks in
Print Preview mode and are displayed
just as they would be printed.

© 2019. DXC Technology Company. All rights reserved.
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DXC Insurance RISKMASTER™ v.19.1 screen

Transaction (0016310)

Checks And EOB Reports

The Following Check and EOB reports are attached with this check Batch:

CHECKS

[Fig. 6]

The password to open the Check is the same as the user’s Insurance RISKMASTER login password

DXC Insurance RISKMASTER™ v.19.1 screen

Description From Date To Date

Invoice #

Invoice Amt Amount

Collision

Payee:Naman_21
Total Check Amt: AUD20.00 Department:

AUD 0.00 AUD20.00

[Fig. 7]

Changes allowed:

While no changes are allowed on checks that have been marked “Ready to Print”, yet, the below operations

that can still be carried out:

> Void: The checkbox can be selected to
void the transaction.

» Check Number: Data in this field can be
entered manually. Doing this will
automatically change the Distribution
Type to Manual and change the Check
Status to Printed.

Note:

» Any Transaction or Control Numbers
generated owing to the Transaction
being marked Ready to Print will also be
marked — Ready to Print.

Precheck Batch Register Screen — Changes & Impacts

On the Precheck Batch Register screen, all the transactions selected for the batch will be marked as Ready

to Print after creation of the batch.

At this stage, all standard businesses which apply to Print Checks will be applied on the Precheck Batch

Register.

© 2019. DXC Technology Company. All rights reserved.
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Supervisory Approval Screen — Changes & Impacts

New additions to the Supervisory Approval screen
[Fig. 8] under the Payments tab include:

» Ready to Print (checkbox)
»  Print Preview (column)

Supervisors can now mark transactions as Ready
to Print so that no future changes can be made
post approval.

Note:

»  Print Preview displays the check as was
earlier visible on the Transaction screen
which shows all applicable financial
adjustments.

» Rejected transactions are not marked
Ready to Print.

> The Ready to Print checkbox on the
supervisory screen will be governed by
the SMS permission.

DXC Insurance RISMKASTER™ v.19.1 screen

Supervisory Approval

(5 X

Supervisory Approval

Bulk Check Release Screen — Changes & Impacts

Payment with Unapproved Payee Status Override Amount |0 Apply Offset Ready to Print
Claim Currency v

m~ | Fund Date” | Type ” | Payee ¥ | Amount 7 | split Amount | Trans Type | Reserve Type 7| print Pre™- flcomme- | submitted By ~ | Service Dates ~ | Hold Rea =
06/05/2018 | Payment STEVEN SMITH UsD 250. UsD 250.00 ND Independent A~ | EXP Expense Paym™ |E | E Exceeded F
06/05/2018 Payment STEVEN SMITH USD 10.00 | USD 10.00 LCE Non-Litigated EXP Expense Paym- |E | E Exceeded F

4 »
otal Items: 2
[Fig. 8]

All queued transactions are processed on the Bulk Check Release screen. New additions on this screen [Fig.

9] include:

» Ready to Print (checkbox)
» Current Status (dropdown)

The new enhancement allows marking multiple transactions as Ready to Print in one go.

© 2019. DXC Technology Company. All rights reserved.
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DXC Insurance RISMKASTER™ v.19.1 screen

Bulk Check Release @ E

Released Payments

el

Total Unselected: AUD 8508.48 Total Selected: AUD 274.00

Ready To Print u

Select the payments that need to be marked as Ready to Print; Then select ‘Process’ to process

Client ¥ | Control Nu~" | Transaction ™ | Payee Name ~ | Claim Number | Amount * | Trans.Type ~ | Account Na-*

0015990 03/06/2019 naman21 011085 AUD 14.00 €123-C123,C | DDA

0016001 03/06/2019 BF5 011082 AUD 240.00 ms-ms feb7_bank
0016013 03/07/2019 naman21 011089 AUD 20.00 HB-Hospital =~ | DDA

0016015 03/07/2019 naman22 011089 AUD 20.00 PP-Partial Pa~ | DDA

[Fig. 9]

Current Status When the Released option is selected [Fig. 9]
R-Released v from the Current Status dropdown, on the

\ 4

R-Released search results window:
Q - Queued Payment

» The Ready to Print checkbox is selected
by default.

» The Ready to Print checkbox cannot be
unchecked.

When the Queued Payment option is selected [Fig. 9] from the Current Status dropdown, on the search
results window users can either select either Printed or Released options from the Target Check Status
dropdown.

Users can only mark transactions as Ready to Print from this screen if the requisite SMS permission is
provided.

Target Check Status: When the Printed option is When the Released option is
selected: selected:
P - Printed v
R- Released » The Ready to Print » The Ready to Print
) checkbox is selected by checkbox is not selected

P - Printed

default. by default.
» The Ready to Print » The desired number of

checkbox cannot be checks can be marked
unchecked. Ready to Print.

Enhanced Stop Pay Transaction

Earlier, the Void checkbox on the Transactions screen was enabled only when Stop Pay checkbox was
selected for a payment. Considering the feedback and requirements of clients, some alterations have been
made in the latest release version of Insurance RISKMASTER v.19.1.

Now the Void payment option will not get enabled whenever a payment is stopped. Now, the system allows
recall of transactions marked Stop Pay and the checkbox for Void payment will be disabled whenever a
payment is stopped.

The Stop Pay checkbox is disabled for all the payment options by default. It gets enabled only after the Stop
Pay request has been accepted.

© 2019. DXC Technology Company. All rights reserved.
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The Void options will be enabled, making it possible to check the same if the Stop Pay has not been
approved as shown in [Fig. 10]

DXC Insurance RISKMASTER™ v.19.1 Screen

Event (EVT2019001961 * 04/04/2019) / GC (2019001942 * DU, VU ) | Financials/Reserves | Transaction (0001795) x]

el ME N EEEREE

Transaction -~

B Transaction Info

Payment Cleared Void Collection
| =
Final Payment Auto Check? Combined Payment? Supplemental Transaction
Ready To Print Enclosure
| |
Stop Pay
[Fig. 10]

Once the Stop Pay request has been raised and accepted, the Stop Pay checkbox is checked and the Void
option gets disabled. [Fig. 11]

DXC Insurance RISKMASTER™v.19.1 Screen

Event (EVT2019001961 * 04/04/2019) / GC (2019001942 * DU, VU ) / Financials/Reserves /| Transaction (0001795)
T
[+]a]a]&]me)s]@][>]ole]@]=]-]
B Transaction Info -
Payment Cleared Void Collection
(]
H| Final Payment Auto Check? Combined Payment? Supplemental Transaction
Ready To Print Enclosure
(]
Stop Pay
(]
[Fig. 11]
Note:

» When a Payment has been marked » When Stop Pay is accepted, then, Pay
Stop Pay, the Payment Amount will be Status will be updated for dependent
deducted from the Paid Total and the Transactions only.
same will get added to the Reserve » Additionally, Stop Pay status of the
Balance. dependent transaction will be

» The “Undo” release will not be allowed synchronized with the main
on any Transactions that are made on Transaction.

POINT and Integral Polices.

© 2019. DXC Technology Company. All rights reserved.
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Enhancement of Average Weekly Wage (AWW) Calculations

The Average Weekly Wage (AWW) Rate Calculations module which works only for Non-Occupational
Claims and Workers Compensation Claims has been modified in this release version of Insurance
RISKMASTER. The module now can compute Average Wages for Salary/Earning and Weekly Earnings
calculated on a per day and per hour basis.

Prerequisites for enabling/using AWW
For information on Calculator
Click Here * procuring this
feature. » JurisRules.exe must run on the server
» The Curranci Tuna must bhe 1ISD.

The AWW Rate Colculationsl AW toolbar button can be accessed from the Employment Info accordion.
[Fig. 12]. Selecting the icon opens the Workers Comp Average Weekly Wage popup window.

The Workers Comp Average Weekly Wage popup window [Fig. 12] has been redesigned to process the
calculations.

DXC Insurance RISKMASTER™ v.19.1 ~ Please Select - v

-- Please Select -

Event (V2019014573 *04/01/2019) / Workers Comp. (WCWCV22019011533)

Workers Comp Average Weekly Wage [WCWCV22019011533]

@ _— Weekly Earnings (Hrs Wise)

Constant Wage Include Zero Amts in Calc Weekly EBI’WHES(DB"’W\SE}
¥ 5 ¥

USD | $928.00

All Bonuses Last Work Week Ear:

Salary / Earning
USD | $0.00

USD | 50.00 USD | so0.00 UsD | s0.00 USD | 50.00
USD | $0.00 UsD | s0.00 UsD | 50.00 USD | 50.00
USD | 50.00 USD | s0.00 USD | 50.00 USD | 50.00
m USD | 50.00 UsD | s0.00 usD | 50.00 USD | 50.00
USD | 50.00 USD | s0.00 UsD | s0.00 USD | 50.00
USD | 50.00 UsD | s0.00 usD | 50.00 USD | 50.00
USD | 50.00 USD | s0.00 UsD | s0.00 USD | 50.00
USD | 50.00 USD | $0.00 USD | $0.00 USD | 50.00
USD | 50.00 USD | s0.00 UsD | s0.00 USD | 50.00
USD | 50.00 USD | $0.00 USD | $0.00 USD | 50.00
USD | 50.00 USD | so.00 UsD | $0.00 USD | 50.00
USD | 50.00 USD | so0.00 UsD | s0.00 USD | 50.00
USD | $0.00 UsD | s0.00 UsD | 50.00 USD | 50.00
Last Average Wage Average Wage
USD |50.00 USD | 50.00 -
[Fig. 12]

Screen Components:
Command Toolbar

The Workers Comp Average Weekly Wage
popup window includes: 7 E ﬁ (:) Return AWW

Constant Wage (data entry field) I
All Bonuses (data entry field)
Last Average Wage (data entry field) Clear
Average Wage (data entry field)

Last Work Week (date selector gadget)
Earning Types (dropdown)

Include Zero Amts. in Calc. (checkbox)
Command Toolbar Set All

Calculate

YVVVVYVVYY

Earning Types dropdown components

» Weekly Earning (Hourly)
» Weekly Earning (Daily)
» Salary/Earning
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Calculation of Salary/Earning

Selecting the Salary/Earning option from the Earning Type dropdown populates the Salary/Earning tab
and its associated dropdown & data entry field — Pay Period Type and Salary Earnings respectively. [Fig.

13]

DXC Insurance RISKMASTER™ v.19.1

tEla]s]

Constant Wage

USD |s928.00

All Bonuses

USD |s0.00

B8 Salary/Earning

Event (EV2019014573 * 04/01/2019) / Workers Comp. (WCWCV22019011533)

Include Zero Amts in Calc

Last Work Week

Earning Types

Salary / Earning

Pay Period Type

- Please Select -

Salary Earnings

USD |$0.00

[Fig. 13]

\ 4

- Please Select -

Bi-Manthly(6 Per Year)

Bi-Weekly(26 Per Year)
Monthly(12 Per Year)
Quarterly(4 Per Year)

Semi-Annual(2 Per Year)

Annual(1 Per Year)
Weekly(52 Per Year)

Semi-Monthly(24 Per Year)

BB X

Workers Comp Average Weekly Wage [WCWCV22019011533] x|

Constant Wage is arrived at after the requisite details are provided in relevant fields including the Salary
Earnings field. This followed by selecting the Set All command button calculates the Average Wages.

Calculation of Weekly Earning (Hourly)

Selecting the Weekly Earnings (hourly) option [Fig. 14] from the Earning Type dropdown populates the
Weekly Earnings (hourly) tab and its associated data entry fields — Hours Per Week and Hourly Rate

respectively.

DXC Insurance RISKMASTER™ v.19.1

[[elal]

Constant Wage

USD | $928.00

All Bonuses

USD | $0.00

Bl Weekly Earnings (Hrs Wise)

Event (EV2019014573 * 04/01/2019) / Workers Comp. (WCWCV22019011533)

Include Zero Amts in Calc

Last Work Week

Earning Types

Weekly Earnings (Hrs Wise)

Hours Per Week

Hourly Rate

UsD | %0.00

Workers Comp Average Weekly Wage [WCWCV22019011533] '

HBEX

[Fig. 14]

“Constant Wage” is arrived at after the requisite details are provided in relevant fields including the
“Weekly Earning (Hourly)” field. This followed by selecting the “Set All” command button calculates the

“Average Wages™.
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Calculation of Weekly Earning (daily)

Selecting the Weekly Earnings (daily) option [Fig. 15] from the Earning Type dropdown populates the
Weekly Earnings (daily) tab and its associated data entry fields — Work Days Per Week and Daily Earn
respectively.

DXC Insurance RISKMASTER™ v.19.1

Event (EV2019014573 * 04/01/2019) / Workers Comp. (WCWCV22019011533)

Workers Comp Average Weekly Wage [WCWCV22019011533] <

Constant Wage Include Zero Amts in Calc

USD | $928.00

All Bonuses Last Work Week Earning Types

UsD | $0.00 Weekly Earnings (Day Wise) v

I B8 Weekly Earnings (Day Wise)

USD | $185.60

| Wwork Days/Week Daily Earn

[Fig. 15]

Constant Wage is arrived at after the requisite details are provided in relevant fields including the Weekly
Earning (Daily) field. This followed by selecting the Set All command button calculates the Average Wages.

Implementation of Post-Mortem Interest Calculations (Life Claim)

Continuing the trend of introducing innovations and improvements in successive releases, Insurance
RISKMASTER v.19.1 enhances the existing Life Claims module, by implementing a new functionality for
calculating Post-Mortem Interest (PMI) in the current release.

Post Mortem Interest can be described as a

federal statutory interest rate levied on the To read a detailed

proceeds of a Life Claim which is calculated on document on the Post-

the number of days ranging from the date of Mortem Interest

death till the date of payout. Calculation functionality
Click Here introduced in this version,

For information on along with details of the
. . Life Claim module
Click Here * f;gfl:‘rr;ng this introduced in the

previous release version.

Displaying Printed & Allocated Reserves

Based on user feedback, the need for displaying Printed Amount & Allocated Amount has been addressed in
this release version of Insurance RISKMASTER in the form of new buckets on the Reserve screen [Fig. 16] for
the said amounts. Previously, only the total amount Paid was displayed on the Reserves screen without
indicating the quantum of reserves available.

Preliminary Settings: Printed/Allocated Amounts are available on:

To view the Printed & Allocated amounts on the
Reserve screen and Financial Summary screen,
the Display Reserve Allocation on Summary
Screens checkbox must be selected under
Utilities > General System Parameter > Funds
Settings

Financials/Reserves

Claim Reserve Summary
Policy/Coverage/Unit Financial
Summary

Quick Summary

Executive Summary

VYV VVY
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Event (EVT2019002124 * 03/02/2019) / GC (GCAPVOMIG2019002097 * AKASH AGRAWAL, AKASH ) / Financials/Reserves

HBEE

Reserves (General Claim [GCAPVOMIG2019002097 * OMIG * AKASH AGRAWAL, AKASH ])

B EEEEaEE

Loss Type Reserve Type Balance Paid Printed Amount ¥ | Allocated Amount ~ [ collection Incurred Benefit Reviey =
1] ] | 1 ] | ] [ | | | |

Li= (1212111

Claim Currency: CAD ¥

<

EXP Expense Payment $200.00 $0.00 $0.00 $0.00 $0.00

$200.00 ‘

4 »
Total Items: 1

*Total will not be changed according to the filter. Total Balance: $200.00 Total Paid: $0.00 Total Collection: $0.00 Total Incurred: $200.00

[Fig. 16]

Improved Financials Screen

The improvements introduced in the Financials screen provide an enhanced user experience with a marked
reduction in the number of clicks, making navigation conducive to the users’ workflow. This is exhibited in
the improved Financials/Reserves screen [Fig. 17] which now displays the following:

» Total Balance - .
> Total Paid Preliminary Settings:
» Total Collection . .
> Total Incurred The following settings must be turned on under
Utilities > LOB Parameter Setup > Reserve/
Incurred Balance Options:
Note: » Calculate Recovery Reserve to Total
Claim Reserve Balance
> The Totals displayed on the » Calculate Recovery Reserve to Total
Financials/Reserves screen will be in Claim Incurred Balance
sync with those displayed on the Claim > Calculate Collections in Reserve Balance
Reserve Summary screen. » Calculate Collections in Incurred
» All expected values are displayed when Balance
financial calculations like Payments, » Calculate Collections in Reserve Balance
Collections, Voiding Payments, Creating Per Reserve
Reserves, Closing Reserves and » Calculate Collections in Incurred
Changing Amounts etc. are performed. Balance Per Reserve

DXC Insurance RISKMASTER™ v19.1 screen

[Total Items: 1

*Total will not be changed according to the filter.

ITotaI Balance: $184.00 Total Paid:$16.00 Total Collection: $0.00 Total Incurred:$200.00|

Event (EVT2019001977 * 02/14/2019) ' GC (2019001958 * test_viewpost, AKASH ) | Financials/Reserves E
[ Roserves (Gonra Clam Q01001688 - wstviewposi AKASH) |
(¢]
Claimant Reserve Sub Type Reserve Type ¥ | Balance ¥ | Paid ~ | Printed Amou-~ | Allocated Am-- | Collection Incurred =
|| || /L1l || || ||| || /L1l
test_viewpost,-- EXP Expense Payment $184.00 $16.00 $16.00 $0.00 $0.00 $200.00

[Fig. 17]
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Payment Approval Performance Improvement

With performance improvements applied to the Payment Approval process, this release version provides the
capability to hide the columns of the grid on the Supervisory Approval screen as the need may be. Also, the
loading time of the grid is markedly reduced with the removal of the corresponding joins of the columns in
Oracle queries.

Unwanted column(s) of the grid can be hidden by clicking on the icon as shown in the figure below followed
by selecting the column name(s). [Fig. 18]

DXC Insurance RISKMASTER™ v.19.1 Screen

Supervisory Approval

)
El(c]iw][#]<]

Claim Currency v

Claim Number | Reserve Typev Reserve Am-~ | Incurred Am--~ | Prior Reserve -~ | Submitted E!yv Date Submitt--- | Benefit Revie--~ | Benefit Cease -~ | Hold Reason ~

@

| | | | | | | | ]| | ]| | ] | ]| | ]| |
[Fig. 18]
[ —
Note: MR CEHo
Clear all filters

» The columns of the grid will be listed as -

shown.
» Deselecting the checkmarks against the R at

fields will hide the corresponding v Reserve Type

columns in the grid.

» The joins of the specific hidden columns
are removed, and the overall load time is v Incurred Amount
reduced.

~ Reserve Amount

« Prior Reserve Amount

Customizable Policy Validations

The feature of customizable Policy Validations has been introduced in Insurance RISKMASTER v.19.1 only for
the POINT Policy Interface. This has been done by exporting the Business Rules [Fig. 19] to the RISKMASTER
Business Rule Editor. When the requisite General System Parameter settings are enabled, modifications to
Business Rules applied to attached POINT Policies can be customized as required.

For e.g., by default cancelled policies cannot be attached to a Claim if that Claim is logged after the Policy
Cancellation Date. Now, with this new enhancement is place, overwriting default Business Rules becomes
possible and even Cancelled Policies can to be successfully attached to Claims without receiving any
validations.

General System Parameter Setup settings Note:
To enable Policy Validations customization for » This enhancement has been
POINT Policies, go to Utilities > General System implemented only for the Point system.
Parameter Setup > System Settings (tab) > Use > This is currently available for only
Rule Engine (checkbox must be checked) “RISKMASTER Business Rule Engine” and
not any other rule engines.
»  All other Policy System validations will
For information on remain unchanged.
Click Here * procuring this
feature.

© 2019. DXC Technology Company. All rights reserved.
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DXC Insurance RISKMASTER™ v19.1 screen

utilities / Riskmaster Business Rule Engine

[B][s]

—

WFWT

dPD

Policy validation

bjPolic

WPOLICYVALIDATE

WPAYG

WBGST

Dim sLos:
Start User Co

viodel.BusinessRuleModelOut = finalOutput

ationModel As PolicyValidat
alidationModel.BusinessRuleModelOut

ionModel)

B

Riskmaster Business Rule Engine

Claims Desktop (CDT) Integration

As per the roadmap, this release of Insurance RISKMASTER integrates a DXC legacy product called Claims

[Fig. 19]

Desktop or CDT. This tool gives a consolidated view of Claims and Vendors servicing them. [Fig. 20]

Claims Desktop

Claims

Claim Type:
Homeowners Property

Closed Date:

Doutstanding Salvage

DSpeciaI Investigation

Loss Handling Office:
Boston, MA

Loss State:
Massachusetts

Occurrence Number:
Authority Contacted:
Loss Description:

Testing email address

Insured Unit:
Owners:

Add Insured Unit

Change

Process Financials
Loss Information
Document Print
Comments

Claim Summary

Policy Symbol:
HMA

Policy Number:
0223227

Claim Status:
Open

[Jou tstanding Subrogation

Primary Handler:
OTA Liability Claims

Loss Location:
Unk

Loss City:
Unk

Catastrophe Number:
Report Number:

0000 20 CUSTOM BOSTON, MA 02110

Add Third Party Auto Unit
Add Third Party Property Unit

Display
Financial History
Salvage

Options | Claim Index | Exit | Help

] OQutstanding Recovery

Claim Number: BOS00006607
Loss Date: 04/15/2017
Policyholder: CHUCK TEST-EBILL
Phone Number:

Add Injured(s)

Injured's Associated Client(s)
Claim Client Summary
Subrogation

Activity Log

Work in Process

[] Litigation

Salvage: No

Subrogation: No

[Fig. 20]

CDT integration will be applicable on General
Claim, Vehicle Claim and Property Claim.

General System Parameter Setup Settings

Go to Utilities > General System Parameter
Setup > enable Use Claims Desktop.

© 2019. DXC Technology Company. All rights reserved.
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Enabling the “Use Claims Desktop” field will enable the Claim Desktop URL and the user can enter the claim
URL.

If this setting is enabled, then, the entered URL in this section will be displayed on the Claim screen. To view
the same, go to the Claim screen and click on the icon shown in [Fig. 21].

Clicking on “Claims Desktop” icon shown in [Fig. 21] will automatically redirect the user to the URL that
was mentioned in the Utilities screen. The URL will open in New Tab.

DXC Insurance RISKMASTER™ v19.1 Screen

General Claim [GC1_LSShh000290 * bbb * ]

m = 3 ) .
1O R EIEREIEIR G
Claim Info
Event Number * Date Of Event~ Claim Number * Time Of Event *
2019000322 03/10/2019 GC1_LSShh000290 12:00 AM
Policy LOB Date Of Claim - Claim Type - Time Of Claim -
H‘ 03/10/2019 1.LSS1 LS 12:00 AM
[Fig. 21]
For information on Note:
Click Here * procuring this
feature. » The claim will be visible on the screen of
the new window that opens on clicking

the “Claim Desktop URL”.

» Additionally, only those claims will open
with CDT which have units attached to
them.

Logging Rolled and Routed Information for Diaries

In the previous versions of Insurance RISKMASTER, the Rolled and Routed information was automatically
saved and displayed in the Task Name column making it difficult to view and read the Diary List. To make
Dairy tracking convenient, Insurance RISKMASTER v19.1 has introduced a Log Information column which
displays the details of Rolled and Routed information instead of displaying them under Task Name.

The users get an option to change the User and Date of the Dairies in the Claims with Route and Roll options
respectively.

Roll

Route _

DXC Insurance RISKMASTER™ v.19.1 Screen

v v ~

Bl I~slolSIBI[@][ - s ]

Colo-~ Priority Due Task Name = Work Activity Routable Roj
L Ja|] @ || la L Ja
@ & @ °rio TREANE 2002_funds_aute_batch ;. autoc0000809 Yes Yes
[ | (0 Optional 03/13/2019 21319af Yes VS
[Fig. 22]
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To view the information, select the Diary and click on the Magnifier in the Log Information. [Fig. 22]

DXC Insurance RISKMASTER™ v19.1 Screen

Diaries [You are currently looking at csc’s diary(s).]
[BllAlv]~][=]lS]&][@] ¥ - |[mese]-]

v

FullN--~ | Claimant Department Claim Status Attach Record ¥ | Parent Record b Log Information
la || la || la L la
YEHICLES3/1343 Q I
[Fig. 23]

The information of that Diary will be displayed as shown [Fig. 23]. Similar Log Information column has been
added in the History section as well. The same information will be displayed here. [Fig. 2]

DXC Insurance RISKMASTER™ v19.1 Screen

[©]
Action ~ | From Date ¥ | To Date ~ | From User ¥ | To User M =
| ||l & || & || [a | la
Routed 02/08/2019 02/08/2019 fut dxc
Rolled 02/08/2019 02/08/2019 1ut 1ut
[Fig. 24]
Additionally, the Log Information column is Not
ote:

multilingual complaint as well. A new Diary Log
option has been added in the Localization Setup

of the Utility screen. The log information will not be created for the

existing diaries if the user is upgrading from the
previous version to the latest release version of
Insurance RISKMASTER. The log information will
only be created for the new diaries after the
upgrade is done.

Thus, the log information can be displayed in
multiple languages.

Framework for Electronic Data Interchange (EDI)

Validation

The basic functionality of EDI Validation is to automate the process of tracking, detecting and rejecting the
EDI files with anomailies.

Insurance RISKMASTER v.19.1 now offers an EDI Validation framework for Worker Compensation Claims to
identify the discrepancies between the Standard Exchange Format and the EDI file.

The EDI Validation option will be displayed in the Worker Compensation screen only for the users who have
purchased EDI.

The “EDI Validation” option will be displayed in the main menu of the Claim screen. There are two buttons
on this page, FROI (First Record of Injury) and SROI (Second Record of Injury). [Fig. 25]
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DXC Insurance RISKMASTER™v.19.1 Screen

EDI Validation (WC2019001933)

EDI Validation

Filing Type

Status

History

FROI

STARTED

[Fig. 25]

Every time the user clicks on any of the Filing options a new row is created in the above screen. The initial
status of the Filing Type is Started. The entire row refreshes after regular intervals and the status changes.
Once the status is changed from Started to In-progress, the errors will be listed in the textbox below as

shown in [Fig. 26].

DXC Insurance RISKMASTER™ v19.1

Validation started for FROI{click @ hereffo Cancel the validation

1. There is No Policy for this Claim,WC2018001704

2. This Claim does not have a Policy and the Employer, , is not Self-Insured; Insurer
3. Claim Disability Type did not resolve to lliness or Injury

4. Field DNOOOS6: Insurer FEIN is missing and expected for all jurisdictions

5. Field DNOO14: Claim Administrator Postal Code is missing

6. Field DNOO44: Employee First Name is missing for claim number

7. Field DNO0O50: Employee Mailing Postal Code is missing for claim number

8. Field DN0052: Employee Date Of Birth is missing and required for claim number
9. Field DNOOO7: Insurer Name is missing for claim number

click [@]

The user can cancel the
validation for the respective
row that In-progress by
clicking on the Cancel the
Validation button. Once it is
clicked, the status of the row
will change to Cancelled.

[Fig. 26]

The entire Error List can be viewed by selecting the icon in the History column of the row. [Fig. 27]

DXC Insurance RISKMASTER™ v19.1

Filing Type

w

Status

History

FROI

[Fig. 27]

Note:

FROI or SROI.

Only one job can be processed at a time.
In case, FROI is already in progress, then, an
error will be thrown in case the user executes

The History icon is enabled once the
validation is either Completed with Validation
Error or Completed Successfully depending
upon the job conditions. The user can view the
Error History popup by clicking on the icon.

Configurable Person Involved Menu

The capability to configure the Person Involved menu with the help of an updated Code Relationship screen
has been introduced in this release version.

© 2019. DXC Technology Company. All rights reserved.
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The preexisting Role and Component option
available in the Relationship Type dropdown, has
now been renamed as Role and Component for
Existing Entities and a new entry Role and
Component for New Entities has been added.
[Fig. 28]

Thus, making separate mapping of Roles and
Components for Existing and New Entities
possible.

DXC Insurance RISKMASTER™ v.19.1 screen

Claim Type And Loss Component
Coverage Type and Reserve Type
Coverage Type and Transaction Type
Deductible Type And Coverage Type
Jurisdiction And AlA Codes 12
Jurisdiction And AlA Codes 34

Jurisdiction And AlA Codes 56

Utilities

Code Relationships

Relationship Type Claim Type And Loss Component

Policy LOB And Claim Type

Policy LOB And Policy Type

1

v Role and Component For Existing Entities

Relationship SubType Claim Type To Loss Component

Role and Compone 0

Claim Type LT - Lost Time

MO - Medical Only
LB - Liability

PR - Property

TL - Towing & Labor
VA - Property

CMP - Property

LO - Loss Other

Days Calculation Method And Reserve Type

Reserve type and Limit Type

Loss Component

Available: Related:
IL- Injury Loss - > -
PL - Property Loss
VL - Vehicle Loss
LL - Liability Loss >
SUL - Other Unit Loss
SL - Site Loss
<
- << hd
[Fig. 28]
Impact on Add Person Involved Screen Note:

The Add New and Existing options will be
displayed on the Add Person Involved screen
based on mapping. [Fig. 29]

All preexisting mapping for Role and
Component for Entities will by default be
available for Role and Component mapping for
New Entities.

DXC Insurance RISKMASTER™ v.19.1

Event (EVT2019002407 * 04/13/2019) / GC (GC2019002374 * testing12334 )
Persons Involved

Employee

+ Q

[=]

Other Person

+ Q + Q

Witness

+ Q

[==]

Driver

Patient

Medical Staff

+ Q
Physician

+ Q

[Fig. 29]
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Easy Accessibility of System Error Messages

Accessing System Error messages easier with the
deployment of the MongoDB. This not only makes
working with databases intuitive by allowing for a

faster and more responsive system but also makes ‘ I I l O n g 0

actively logging and viewing of errors possible in
real-time in the Error Tracer module under the
Technician’s Menu of the Utilities zone. [Fig. 30]

DXC Insurance RISKMASTER™ v.19.1 Screen
Utilities / Error Tracer B

Error Tracer

Date Range:

Action Originator App Domain Name Message Log Browser/Ma.. Priority Date Time b
(http://170.30,50.16/riskmasterux/rmaCommon/scripts/vendor js:33:214. -
: FDI AP Riskmaster.SOR Object reference not set 1o an... at Riskmaster.SOR.Controllers.TransactionController.GetSplitLink) in RMA-WEB2 ) 04/04/2019 6:05 AM

e\Home\build\buildrmaGH184\Source\Build RMACDRGH18.4-
274\Riskmaster\RiskmasterAPI\Riskmaster.SOR\Contraollers\Transaction...
549 at

Riskmaster.SOR Controllers.TransactionController.ProcessResponse() in

e:\Home\build\buildrmaGH184\Source\Build RMACDRGH18.4-

274\Riskmaster\RiskmasterAP! SOR\Controllers\Transaction...
485 at Riskmaster.SOR.Controllers.BaseController.
<PracessRequest>d_c.MoveNext() in

e:\\Home\build\buildrmaGH184\Source\Build RMACDRGH18.4-

274\Ri: \ asterAPI\RI SOR\Controllers\BaseControl... =
[Fig. 30]
Log DetailsD x Note:
e e > The need to physically log into the server
prierty: 0 to view error logs has been negated as
Ctlr 18 unknown the logged details can be viewed in a

web interface itself.
»  Error Log Details can be viewed by

Target D § N: unknown

Severity: Error

\ 4

selecting the icon in the “Action” column.

Title:

Timestamp: 20190404060558

Timestamp Taxt: 04/04/2019 6:05 AM

Machine Name: RMA-WEB2

App Domain Name: Riskmaster. SOR

Message: Object reference not set to an instance of an object,

stack Trace: at Riskmaster. SOR Controllers. TransactionContraller.GetSplitLink() in
e\Home\build\buildrmaGH184\Source\Build RMACDRGH18.4-
274\Riskmaster\RiskmasterAPI\Riskmaster. SOR\Controllers\TransactionController.cs:line 549 at
Riskmaster.SOR Controllers. TransactionController.ProcessResponse() in
e\Home\build\buildrmaGH184\Source\Build RMACDRGH18.4
274\Riskmaster\RiskmasterAPN\Riskmaster. SOR\Controllers\BaseController.cs:line 576 --- End of stack
trace from previous location wi
System.Runtime.ExceptionService:

here exception was thrown --- at
s ExceptionDispatchinfo.Throw() at

System.Runtime.CompilerServices TaskAwaiter. HandleNonSuccessAndDebuggerNotification(Task task) at

System.Runtime.CompilerServices.TaskA er'1.GetResult() at

Riskmaster. SOR Controllers TransactionController. <GetFundsTransaction=d__1.MoveNext() in
e\Home\build\buildrmaGH184\Source\Build RMACDRGH 18.4-
274\Riskmaster\RiskmasterAPN\Riskmaster. SOR\Contrallers\TransactionController.csline 68

Lag Type: AP|
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Recording & Tracking Claim Type Changes

Insurance RISKMASTER v.19.1 offers the option to record and track changes in the Claim Type for Claims.
[Fig. 31]

DXC Insurance RISKMASTER™ v.19.1 screen

Event (EVT2018001980 * 12/01/2018) / GC (2018001961 * Akash Agrawal )

General Claim [2018001961 * * Akash Agrawal]
[BIE)=)0][a]mE]E]kEEE=]-]
Claim Info o

Event Number * Claim Number = Policy LOB * Claim Type *

EVT2018001980 CMP Property

2018001961

[

APV Auto Private Passenger

Department Claim Status * Date Closed Close Method

m O Open

[Fig. 31]

A new button Status Detail has been added to the
Claim Type field which allows users to
conveniently change the Claim Type and view all
previous changes made to it.

Selecting the Status Detail button opens a new
pop-up window — Claim Type History. [Fig. 32]

Claim Type History (popup window) Notes:

The Claim Type History pop-up window [Fig. 32]

» The Claim Type & Date fields are

has the following:

mandatory. The Date field displays the
current date by default & can be

Fields Toolbar Buttons overridden by the user.
» Claim Type > OK » The Changed By column displays the
> Date » Cancel name of the user who changed the
> Reason >  Print Claim Type on the selected Claim.

DXC Insurance RISKMASTER™ v.19.1 screen

Claim Type History [ 2018001961 * Akash Agrawal * ]

MELE

Claim Type

Date

02/18/2019

Reason

Date

Claim Type

Changed By Reason

LO Loss Other 05/08/2018

LO Loss Other 04/26/2018

PR Property 04/15/2018

[Fig. 32]
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Recording & Tracking Claim Review Information

Insurance RISKMASTER v.19.1 offers the option to track the complete information of the Claims being

reviewed with a “particular status” (e.g. Accepted, Denied, Delayed etc.) [Fig. 33]. A new history lookup field
labelled as Review Status has been added in the Claim Info accordion. The history of any changes made to

the Review Status field can now be tracked and can be viewed in a separate popup screen accessible from

the Claim Info accordion.

DXC Insurance RISKMASTER™v.19.1 Screen

General Claim [GCAPV210/BELCAMP201800203 * City of Oak Hills * DU, VU]

[ B0 &mE3) B

E)

=

it

» The Claim Review Status field will be
visible in the Mail Merge template and
will even work in PowerView.

The Review Status with the values will
even be displayed in Executive
Summary of transactions.

Event Number * Date Of Event* Claim Number * Time Of Event*
EVT2018002055 01/01/2018 GCAPV210/BELCAMP201800 12:00 AM
Policy LOB - Date Of Claim - Claim Type - Time Of Claim -
H‘ APV Test APV Tesl 01/01/2018 APV APV 12:00 AM
Department * Review Status Event Date Rptd. Claim Status *
210/BELCAN E O Open
[Fig. 33]
Note Review Status

= =

Review Status History

Claim Review Status

Review Status History Pop-up

Selecting the Review Status History will display
a popup showing the review status history [Fig.
36]

The popup window includes following fields:

> Review Status
» Date
» Changed by

Claim Review Status Pop-up

The Claim Review Status popup window displays
the Review Statuses created in the Maintenance
Table. [Fig. 34]

The review statuses to be displayed in this
section can be created from the “Maintenance
Table” of the Maintenance Screen.

Review Status

Clicking on the status will display the Review History.

© 2019. DXC Technology Company. All rights reserved.
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Note:

The Claim Review Status added in the Table
Maintenance screen will be displayed in the
popup. The user can add new status if required.

Review Status

= [

DXC Insurance RISKMASTER™ v.1.9.1 Screen

Event (EVT2019001961 * 04/04/2019) / GC (2019001942 * DU, VU )

Claim Review Status

Description

Parent Code

Accepted
Compensable
Penied

Relayed

[Fig. 34]

QISE)

To create new Claim Review Status, go to Maintenance > Table Maintenance > Claim Review Status.

Click on the “+” sign on the left top corner of the screen to open the Enter Code Details popup window. [Fig.

35]

Fill the Code Details and Save. The entered Review Status will be displayed in the Claim Info accordion as

shown in the [Fig. 33].

DXC Insurance RISKMASTER™ v.19.1 Screen

Table Maintenance

Enter Code Details

[B]e]

Parent Code
Line Of Business *
Effective Start Date

Mn/ddlyyyy

Effective For

Description *

Industry Standard

Effective Date Trigger

Please Select

Effective End Date

MM/ddlyyyy

Language

English(United States)

[Fig. 35]

Review Status History

The Review Status History details can be viewed by clicking on the icon in the Review Status field as shown
below. This functionality allows the user to view all the detailed history of the claim statuses.

© 2019. DXC Technology Company. All rights reserved.
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The Review Status History popup window [Fig.

Review Status 36] includes the following fields:

> Review Status
> Date
» Changed By
> Reason
¥ DXC Insurance RISKMASTER™v.19.1 Screen
Event (EVT2019001961 * 04/04/2019) / GC (2019001942 ~ DU, VU ) @ E

Review Status History [2019001942*DU, VU*]

Review Status™

Date

04/15/2019

Reason

Review Status Date Changed By Reason

Accepted 04/15/2019 dxc Demo reason

[Fig. 36]

In addition to this, the Review Status will also be visible in the Query Designer section that allows the users
to can create their own query. In case the search type is Claim Search, Review Status will appear as one of
the options in the Field Available for Search. Thus, the Review Status can also be used as a search criterion.

© 2019. DXC Technology Company. All rights reserved.
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Improvements & Enhancements

@

This section of the Release Notes document describes all the interface,

usability and performance related improvements and enhancements that
make DXC Insurance RISKMASTER™ v.19.1 a much more efficient & user-
friendly application.

Improved Performance in Loading of FDM Accordion
Fields

The multi-file attachment feature has been greatly improved upon in this release of the application with an
enhanced Drag & Drop feature. This new development allows uploading multiple files in one instant thereby
saving time.

The following actions must be performed on the
Config Section Key Details window:

Preliminary Utilities Settings
» In the Key Name column, search File
Upload and hit the enter key. The

FileUploadedCount and
FileUploadedSizeLimit will acppear as
shown below. [Fig. 37]

To settings to enable this feature can be
accessed under:

Utilities > Config Settings > Config Section Key
Details

DXC Insurance RISKMASTER™v.19.1 Screen

Config Section Key Details

Section Name Key Name Key Data Type Key Details

| | ri\eupload | | | |
v AppSettingsKeys FileUploadCount Number 10
v AppSettingsKeys FileUploadSizeLimit Number 1000

[Fig. 37]

DXC Insurance RISKMASTER™v.19.1 Screen DXC Insurance RISKMASTER™ v.19.1 Screen
Edit Config Key Data ® Edit Config Key Data ®

[B]e]

Section Name: ™

][]

Section Name: *

AppSettingsKeys AppSettingsKeys

Key Name: * Key Name: *
FileUploadCoun FileUploadSizeLimit
Key Data Type: * Key Data Type: *

INumber Number

Key Details Key Details:

10 000
1000

Click on the Edit button corresponding to
FileUploadedCount option. The Edit Config Key
Data popup will appear. Enter the maximum
number of files allowed for upload in the Key
Details field.

Similarly, click on the Edit button corresponding
to FileUploadedSizelimit option and set the
maximum file size that is to be allowed for the
upload.

© 2019. DXC Technology Company. All rights reserved.
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On the Document List screen, clicking on the Add New or the “+” sign in the top left corner, opens the Add
New Document popup window. [Fig. 38]

DXC Insurance RISKMASTER™ v.19.1 Screen

Event (EVT2019001961 * 04/04/2019) ' GC (2019001942 * DU, VU )

Add New Document

Subject:

Category:

Keywords:

[Fig. 38]

Note:

» File Name of the document being
dragged & dropped into the Add New
Document popup window will be auto-
populated in the Title field.

» Maximum allowed attachment file size is
10 MB.

» An error message will be displayed if
attachment size if over the set maximum
limit.

Performance, Interface & Usability Improvements

As part of Insurance RISKMASTER’s ongoing performance, interface & usability improvement, the following
have been implemented in the latest release v.19.1:

FDM Accordion Fields Loading Performance

Insurance RISKMASTER v.19.1 has greatly improved the efficacy of the application by making it nimbler. Now,
the loading time for existing Claims/Events/Claimants screens along with their respective accordions and
right-pane nodes containing large amounts of data, open smoothly and without any lag or freezing. Also,
the functioning of all command and toolbar buttons and data-entry fields on each screen are clearly visible,
perfectly aligned and function without any glitches.

Enhanced Check Preview Screen

To address the business practice requirements, the capability to Preview Checks to see the Payee Names,
Addresses and Payee Phrases, both prior to and post printing them, has been enhanced in this release
version of Insurance RISKMASTER.

© 2019. DXC Technology Company. All rights reserved.
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Prerequisite SMS Settings: Note:

To enable Print Preview and Print Check » The Print Preview and Print Check

capability on the Funds screen [Fig. 39] to view buttons [Fig. 40] will be available for

Payee Names, Address and Payee Phrases users with SMS permissions.

follow the path below: » The Preview Print function is no longer
dependent on a user's Print Check

Security > Security Management System > rights.

Database > (select DSN) > Module Security » The Print Preview feature will be

Groups > Administrator > RISKMASTER > Funds unavailable for Printed checks.

Management > Print Check > Transactions > » Check Stocks under Bank Account must

Preview Checks & Print Payment Check be configured to include Payee Address

DXC Insurance RISKMASTER™ v.19.1

Security Management System @ E

BROR0EREEEE

© Adjuster - Property - Level
© Adjuster - Property - Level
© Adjuster - Property - Level
© Administration

© Administration Specialist
© Claims Examiner

B | Detach.From -

DXC Insurance RISKMASTER™ v.19.1

Event (EVT2019002144 * 03/02/2019) / GC (GCAPVOMIG2019002117 * ANDERSON, ROBERT) / Financials/Reserves / Transaction (New) Bl X

Funds [GCAPVOMIG2019002117 */ * ANDERSON, ROBERT]

B Transaction Info

[Fig. 40]

Print Preview

Print Check

Improved Left-hand Pane

In the previous versions of Insurance RISKMASTER, the instance of the screen that was open, wasn’t
highlighted in the Work in Progress tab of the left-hand pane. Now, the left-hand pane of Insurance
RISKMASTER v.19.1 highlights the most recent instance of a module in use, thus, making it easily
identifiable. This is especially helpful when several instances of multiple modules are being worked on
simultaneously.

DXC Insurance RISKMASTER™ v.19.1 Screen

Event (EVT2019002223 * 03/15/2019) / Non-Occ (DI2019002181 * testing, 11 )

Non Occupational Claim [DI2019002181 * OMIG * testing, 11]

[B](s]=]a]s)a]nmo]s) k@ w]E] =)

Payment Notification 0
Claim Info A
Recent Claims [x]
. Event Number - Date Of Event - Time Of Event - Date Of Claim -
Non-Occ (DI2019002181 * testing, 11)
[x] EVT2019002223 03/15/2019 12:00 AM 03/15/2019
R it Event: - . - . -
ceentbvents < Time Of Claim * Claim Number - Policy LOB* Claim Type *
H‘ 12:00 AM DI2019002181 nonocc nonocc
[Fig. W]

© 2019. DXC Technology Company. All rights reserved.
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Improved Code Lookup Grid

This enhancement provides filtered search results
Important based on the text input in a Code Lookup field
e.g.: Claim Type, etc.).
To understand this enhancement better, please 9 o : A new Code Lookup
first read the details of the Configurable Text Claim Type + Grid pops on screen
Autosuggest feature in the Administrative & pro | upon s’f-:tlectmg the
Security Enhancements section on page 42 of CMP Property More” button at the
this Release Notes document. PR Property bottom of the auto
V“'F%I suggest options as
— shown on the left.

As mentioned earlier, the Claim Type (Code Lookup Grid) popup [Fig. 42] displays the auto-suggested
options based on the input text. Earlier the “More” button showed all the results that were included in the
respective field.

DXC Insurance RISKMASTER™ v19.1 Screen
Event (New) / GC (New)

Searched Criterion : pro ®

Code ¥ | Description Parent Code
e[ |

Property

Property

Property

[Fig. 42]
General System Parameter Setup Setting Note:
To ascertain the maximum allowed number of » Search results can be filtered.
search results displayed on the new code lookup » The auto-suggest code lookup grid works
grid, input appropriate figures in the Number of for PowerView as well.
Records Per Page section. » For Oracle users, the Search results are
case-sensitive. To make it case

Utilities > General System Parameter Setup > insensitive, go to Utilities -> General
System Settings Tab > Number of Records Per System Parameter Setup and check
Page (input data here) “Oracle Case Insensitive” option.

Improved Logging of Date & Time During Currency Conversions
This enhancement allows accurate logging of the exact Time and Date when the Currency Type was
changed from one to another. For e.g.: AUD to USD. Now, the Date and Time of Currency Conversion will

automatically get updated on the Financials/Reserves screen. [Fig. 3]

DXC Insurance RISKMASTER™ v19.1 Screen

Reserves (General Claim
@ @ S
h--~ | Collection ~ | Incurred | Benefit Review Date | Benefit Cease Date ¥ | status v Adjuster v Currency Conversion Date =
$0.00 $1,000.00 O - Open 03/26/2019 6:11 AM
$0.00 $100.00 O - Open 03/26/2019 2:17 AM

[Fig. 43]

© 2019. DXC Technology Company. All rights reserved.
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In the previous versions of Insurance RISKMASTER, the Currency Conversion Date column only displayed a
maximum of 8 characters. In release v.19.1, this maximum allowed number of characters has been increased
to 12 characters to accommodate accurate logging of Date and Time of currency conversion.

New Date & Time Display Format

MM/DD/YYYY 00:00 AM/PM

© 2019. DXC Technology Company. All rights reserved.

Note:

» The Server’s Date & Time is logged in the

“Currency Conversion Date” column as
the time of Currency Conversion.
Date & Time will get updated on the
following screens:

e Funds Transfer

e Reserve History

e Reserve Creation
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Administrative & Security Enhancements

This section of the Release Notes document describes the technical

information pertaining to Administration & Security related enhancements in
DXC Insurance RISKMASTER™ v.19.1.

These enhancements typically run in the background & are usually dealt with
by the System Administrators and Technicians.

Database & PowerView Upgrade Improvements

The need for production and support issues experienced due to incorrect updating or complete failure of the
Database Upgrade process has resulted in significant improvements being introduced in the current release
of Insurance RISKMASTER. The new Database Upgrade tool enables the tracking and analysis of changes
being executed across the Database along with supporting the induction of custom codes basis the Pre-
Upgrade and Post-Upgrade validations.

Interface Changes Note:
The interface changes owing to the current > Moving Case Management Supplementals
improvements are as follows: can be processed after Database
» Database Error Handling & Logging Upgrade if:
» Searching & Filtering Error Logs ¢ Case Management is ON
» Deprecation of PowerView Upgradation ¢ Moving Case Management
Process Supplementals has not been done
» Pre & Post Upgrade Validations earlier
» Simultaneous Execution of DB Upgrade
on all Databases including: » Moving Case Management Supplementals
o Views e Main DB can also be done independently by
e Security e Session DB running app.config.
e Task Manager > Databases which encountered errors
during previous upgrade attempts can be
To read details of changes upgraded separately.
Click Here in DB Upgrade in the New » Individual progress of each tab, and
Install Instructions overall progress can be viewed in real-
- time.
To read details of changes

Click Here in DB Upgrade in the
Upgrade Install Instructions

Removal of PV Upgrade Tool

The release of Insurance RISKMASTER v.19.1 implements a major improvement in the way the application
handles Databases & PowerViews upgrades. As the two processes are now clubbed, the need for executing a
separate .exe for upgrading PowerViews is negated when the application is upgraded to v.19.1.

With this upgrade, the manual editing of SOQL files is restricted, and all log files can be viewed for any script

or XML changes being executed in the tool. Also, all PowerView changes can be verified post completion of
the upgrade process.

© 2019. DXC Technology Company. All rights reserved.
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Configure Multiple Email APls

Improving upon the emailing options using SMTP (Simple Mail Transfer Protocol) existent in Insurance
RISKMASTER, release version 19.1 enhances the functionality by introducing support for multiple Email APls
provided by independent service providers Mailgun and SendGrid.

Preliminary Security Configuration

The settings can be accessed via Security >
Security Management System > Set E-mail
Options (toolbar button). [Fig. 4]

mailgun

Email Automation

TWILIO
o
For information on SendGrId
Click Here * procuring this
feature.
N To visit the Mailgun website N To visit the SendGrid
Click Here and explore mo?e. Click Here website and explore more.

Insurance RISKMASTER v.19.1 screen

Security Management System

Set E-mail Options

[]o]

B X

SMTP Server

API Provider
()

Mailgun

Sendgrid
[

API Provider URL *

Admin E-mail Address *

API Provider key *

API Provider Domain *

[Fig. 4]

Radio Buttons

Mailgun
SendGrid

» API Provider (radio button)
Under this, there are two more radio
buttons for the supported APl service
providers, namely:

Set E-Mail Options Popup Components

Mandatory Fields:

API Provider URL
Admin E-mail Address
API Provider Key

API Provider Domain

YV VYV

© 2019. DXC Technology Company. All rights reserved.
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Configurable Text Autosuggest

®

Notes:

» Mandatory fields under both Mailgun &
SendGrid radio buttons are the same.

» To successfully send emails using an API
Provider, the email ID in the “Admin E-
mail Address” field must be the same as
the user’s email address.

» Emailing via API Providers is accessible
via the Claims, Events, Diaries,
Attachment & Enhanced Notes screens.

»  “Email Sent Successfully” notification is
displayed each time an API Provider is
used.

» A notification is also sent to the users
email address each time an API Provider
is used to send an email.

The latest version of Insurance RISKMASTER offers a new Typeahead or Text Autosuggest feature for Entity

and Non-entity type fields. [Fig. 45]

With the introduction of this feature, suggestions

based on the text input in the said fields will
displayed automatically.

Moreover, the application allows configuring the
minimum number of input characters required to

trigger the Lookup Typeahead feature.

get

Preliminary Settings

The preliminary settings mentioned below must
be performed to configure this feature.

Under Utilities > General System Parameter
Setup > System Settings (tab) set the minimum
number of characters required to trigger Text
Autosuggest for:
» Lookup Typeahead Min Length (Entity)
» Lookup Typeahead Min Length (Others)

Under the System Settings tab, select checkbox
for Search on Short Code & Code Description.

Insurance RISKMASTER v.19.1 screen

Event (EVT2019002007 * 02/17/2019) / GC (2019001984)

e
pEEElEHEEEEEEE g oo
e —

© 2019. DXC Technology Company. All rights reserved.

e 0@ ®©
Open Reserve TransactionClosed
Event Number ~ Date Of Event~ Claim Number - Time Of Event -~ - o
as Adjuster
EVT2019002007 02/17/2019 2019001984 12:00 AM =
B CIaimamo
Policy LOB~ Date Of Claim~ Claim Type * Time Of Claim ~ N G EnE
‘H FIRFIR 02/17/2019 prd 12:00 AM
VA Property
Department Review Status More Claim Status * Persons Involved o
FS1FF-Fire ¢ 0 Open & pefendant @)
[Fig. 45]
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Field Customization in PowerView Editor

In this release, the tedious tasks of customization operations in the PowerView Editor have been made
conveniently user-friendly. Now, editing the fields of Claim/Event/Financials screens have been rendered
hassle-free owing to an enhanced Screen Configuration option in the PowerView Editor.

DXC Insurance RISKMASTER™v.19.1 Screen
Preliminary PowerView Editor Settings

Event Info LR
To configure the fields in the PowerView, go to Child Buttons
Utility > PowerView Editor.
SeIeCt the POWeereW User Gnd Form Fleld' For * Event Number3 X * Event Type X +*Date OfEvent X *Time Of Event X
e.g.: select Event B o s

Now, click on the “kebab’ button. [Fig. 46] [Fig. 46]

—10_ -

Clicking on the “Screen Configuration” icon on
the Event Info window will open the Screen
Configuration popup window as shown below.

[Fig. 47]

Screen Configuration

Features offered in Screen Configuration are:

» A new lookup, Screen Configuration
Lookup, has been added that enables the
users to Edit or Delete the fields.

» The users can Add new Message section,
New Space, Separators and Accordion in
the Claim Screen.

» The fields can be moved up and down.

» The field can be made “Read Only” or a
“Required” field at a button click.

DXC Insurance RISKMASTER™ v19.1 Screen
Utilities ' Powerview Editor

(]

Form Fields
--Please Select Form Fields-- v ’
Search
=Event Info
sk Event Number(Event Number3)
% Date Of Event
. - s Event Status
Auto Field Number ) (A]

Auto State

Auto Code

Auto Date

Auto Field Entity

Auto Event Number ID
Auto Enter Comments
Auto HTML Text

Auto Vehicle ID

Auto Multi Code

Auto Multi Entity
Auto Multi State

Auto Claim Number ID
Auto Lowest Maintained Amount

v

Auto Entry Time
Auto User ID
Auto CheckBox 1

BIEvent Category
BIDepartment Involved
% Time Reported
BImjury To

*Event Type

[Fig. 47]

Edit

N
=)
<
il
|
Il

Delete

a

Add Accordion

Add New Message Section

Add Separator
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The various configuration options are discussed in detail below:
Edit Field

DXC Insurance RISKMASTER™v.19.1 Screen

To it th fekd n PowerView, select the

respective fields and click on the Edit icon. The
Modify Controls popup is displayed.
Caption * Read-Only The various components of the popup are
Event Category mentioned below:
Help Message Required > Caption (data entry field)
» Read Only (checkbox)
P » Help Message (data entry field)
» Required (checkbox) check the box to
[Fig. 48] enable Required Field Validator.
Delete

To delete the fields in PowerView, select the respective field and click on the “Delete” icon. The deleted fields
will be added in the dropdown menu of the Form Fields. The deleted fields can be added back to the Event
screen by selecting them from the dropdown menu.

Note:

» The fields for which Required Field
Validator is enabled cannot be deleted.

» Any attempt to delete the fields marked
Required, will result in display of an
error message.

Add New Message Section

DXC Insurance RISKMASTER™v.19.1 Screen The message entered will be displayed above

the selected field in the Claim screen. This

@ configuration option allows adding a unique
name or additional information to a given
section.
Caption *

Select any field and click on Add New Message
Section. A popup will be displayed, and the
requisite text can be entered. [Fig. 49]

[Fig. 49]
Add New Spaces
Now, adding spaces between fields has also been made convenient with this release. For e.g.: to add space
to fields, select the fields before which the space is to be added and click on the Add New Spaces button.
This will add spaces in the fields of the Claim screen.

Add Separator

Similarly, separators can be added between the required fields. The separators will appear above the
selected fields.

© 2019. DXC Technology Company. All rights reserved.
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Add Accordion

@

The process of adding a new accordion has also been simplified. Just selecting the field above which an
accordion is to be added followed by clicking the Add Accordion button completes the task immediately.

®
The system now allows naming accordions beginning with special characters.

Additionally, the position of accordions/fields can also be changed by clicking on the Move Up and Move
Down arrow as shown. [Fig. 4+7]

Importing SAML IdP Metadata from Files (SSO)

In previous versions of the application, the IdP (Identity Provider) Metadata had to be manually fed into the
Security Management System. This release onwards, Insurance RISKMASTER allows importing the IdP
Metadata from XML files. These XML files can be uploaded into the system and their metadata will

automatically get populated in the respective fields.

DXC Insurance RISKMASTER™ v. 19.1 Screen

Security Management System

LRI

- @ RISKMASTER SECURITY
© Users
© DataSources

O

Authentication Provider Settings

Prerequisite SMS Setting

Go to Security > Security Management System
Screen, click on the Authentication Provider
Settings icon.

[Fig. 50]

In the Authentication Provider Settings popup, select Single Sign On Provider.

Ins

urance RISKMASTER v.19.1 Screen

[8]®

2]

IDP

Add |dentity Provider

|dentity Provider Name™®

Identity Provider URL*

Single Sign On Protocol*
SAMLZ

Binding Type*
HittpRedirect

SP Issuer*

hittp://170.30.50.205/

Issuer”

User Name Attribute Mapping

Attempt Matching Name ID with Email Address

Enable Single LogOut

Click on the Add or “+” sign on the top left section
to Add new Identity Provider and SAML Settings.

Earlier, the Identity Provider URL, SP Issuer, IdP
Issuer and Single Logout URL fields were provided
manually. Now, relevant data is auto populated in
respective fields by selecting an XML file and
uploading it into the system. [Fig. 51]

For information on
Click Here * procuring this
feature.
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Auto Generation of Self Signed Certificates (SSO)

Security Assertion Markup Language (SAML) allows Identity Providers (IdP) to pass authorization
credentials to service providers which allows the use of one set of credentials to log into many different
websites. SAML is the link between the authentication of a user’s identity and the authorization to use a
service.

Generation of SSO

Earlier, SSO certificates were generated manually. Now, the application’s efficacy has been enhanced with
the introduction of a new feature to auto-generate Self-signed Certificate.

On selecting the Add button, the Add New
Identity Provider and SAML Settings popup is
displayed [Fig. 52] which allows the addition of:

Prerequisite SMS Setting

To use this feature, go to Security > Security
Management System > Authentication Provider
Settings (toolbar button)> Single Sign On
Providers (tab) > select the Add button

» Add Identity Provider
» SSO Certificate

The Identity Provider details can now be entered by simply uploading an XML file as discussed in the
Importing SAML Identity Provider (IdP) Metadata from Files module on page 45. document.

DXC Insurance RISKMASTER™ v.19.1

R x Upon expanding the SSO Certificate option

[Fig. 52] , the following new fields are

[B]e]z] displayed.

Add Idently Provider v » Certificate Name: Enter the name of

the certificate.

| » Certificate Password: Enter a unique
certificate password.

» Generate Self Signed Certificate:
Select this checkbox to enable auto-
generation of self-signed certificates.

» OpenSSI Exe Path: Enter the path

Certificate Name* (.pfx)

Certificate Password®

B8] gonerste soif signed ceriificate where the SSL folder is executed.
Openss! exe path » Certificate will generate here: The self-
signed certificates will appear in the
Certificate will be generated here” thh mentioned in this field.
C\Program Files (x86)\CSC\Riskmaster\userdatalSSOCertificates\ » Certificate Validity Days: The user can
Cortifons valaty days- enter the valdiation period for the
365 generated SSL Certificate.
DXC Insurance RISKMASTER™ v.19.1 Screen
[Fig. 52] Authentication Provider Settings x

The SSO certificate will be created and saved in m
the path specified above.
B[7]5E]8] e

Once the process is complete, a new ldentity

Provider will be created, details of which can be 'TP ST | 'TP &t | II | Sls" B‘”""’l' 5|3°P’ -
edited and downloaded (in .pfx format) by I

. e . . v | . y
CIICkIng on the respeCtIVe buttons as shown [Flg. withoutsso1 https:/partners- https://partners. HttpRedirect | SAML2
53] with sso edit https:/partners: https://partners: HitpRedirect | SAML2

[Total Items: 2

For information on
Click Here * procuring this

feature.

[Fig. 53]
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Identity Provider (IdP) Configuration

The file downloaded will contain the .pfx file that was created & downloaded as mentioned above. The
configuration of the .pfx file can be initiated by double clicking on it.

Steps to Import .pfx File

Follow the steps mentioned below for configuring an IpD:

>

vV VYV VY

Double click the .pfx file > a prompt to choose the Certificate Store Location from the options that
include Current User or Local Machine is displayed. (Choose a desired option & select the “Next”
command button).

Enter the import location and click Next.

Enter the Certificate Password that was created during the configuration of SSO in Insurance
RISKMASTER > click Next.

In the following interface enter the desired location for Certificate storage (Click the Browse button
to select the destination folder > click Next.

Click Finish to complete the configuration process. (The message — “The import was successful” is
displayed if the process was completed without errors).

Steps to Configure the .pfx File

> Now, to configure the .pfx file, go the Command Prompt and enter “mmc”. This will open a Console
as shown [Fig. 54].
DXC Insurance RISKMASTER™ v.19.1 Screen
é Console1 - [Console Root] - O X

]
A

E File Action View Favorites Window Help

New Ctrl+N
Open.. Ctrl+O Actions
Save Ctrl+S

There are no items to show in this view. Sonssalock -
Save As... :

More Actions

Add/Remove Snap-in.. Ctri+M
Options...

1 C\Users\..\Console1.msc

2 services.msc

Exit

[Fig. 54]

Select File > Add or Remove Snap-ins > Certificates > Add. [Fig. 55]

o A prompt to select the radio button for Local Computer under Select Computer appears.
Select the Local Computer followed by the Finish button to add the Certificates folder in the
Console Root.

Select Certificates and click on the Ok command button.

On the next screen, click on the Certificates folder followed by the destination folder for the .pfx file
set earlier on. (Now, all the certificates saved in the folder will be visible).

Doubile clicking a relevant certificate opens a new popup window showing the details of the selected
certificate.

e On the same window — select the Details tab > Copy to File > Next.

e Select “No, do not export the private key” and click on Next.

Select the Browse button to select the export destination folder.

e Enter a name for file that is selected for export.

e Click Next followed by the Finish.

(Upon successfully completing the export, a message “The export was successful” is
displayed).

© 2019. DXC Technology Company. All rights reserved.
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DXC Insurance RISKMASTER™ v.19.1 Screen

Add or Remove Snap-ins X

You can select snap-ins for this console from those available on your computer and configure the selected set of snap-ins. For extensible
snap-ins, you can configure which extensions are enabled.

Available snap-ins: Selected snap-ins:
Snap-in Vendor A _| Console Root Edit Extensions...
Microsoft Corp... Remove
Microsoft Corp...
| Certificates Microsoft Corp...

=. Component Services Microsoft Corp...
g,— Computer Managem... Microsoft Corp...

& Device Manager Microsoft Corp... Add >
= Disk Management Microsoft and ...
Event Viewer Microsoft Corp...
| Folder Microsoft Corp...
" Group Policy Object ...  Microsoft Corp...
.g, IP Security Monitor Microsoft Corp...
,_ﬁ_, IP Security Policy Ma...  Microsoft Corp...
|| Link to Web Address Microsoft Corp... v e ancee

Description:
The ActiveX Control snap-in enables you to add an MMC node with a results view containing an ActiveX control.

[Fig. 55]

The configuration is complete. The exported file can now be uploaded in the third-party Identity Provider
(IdP). Once the upload is done, the Login option will be visible in the login page of Insurance RISKMASTER.

Masking of Banking Information

This release version of Insurance RISKMASTER incorporates improvements that make the application
compliant with requirements for financial audits.

To this end, masking of Banking Transaction Information for an Entity, be it an EFT (Electronic Funds
Transfer) Information Number or a Routing Number, has been made possible. This prevents all non-
authorized users from viewing bank account related information of Payees.

Prerequisite SMS Settings Note:

Insurance RISKMASTER administrators can »  Only Users with requisite SMS

configure Banking Information (EFT Information) permissions can Create/ Delete/

permission settings [Fig. 56] for different Users Masked/ Update/ Edit/ View the EFT

by following the path below: Information on the Entity Maintenance
Screen.

Security > Security Management System > » All EFT Information will be masked for

Database > (select DSN) > Module Security users with no SMS permissions.

Groups > Administrator > RISKMASTER > Entity » Masking of EFT Information will be

Maintenance > Banking Information complete.

© 2019. DXC Technology Company. All rights reserved.
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DXC Insurance RISKMASTER™ v.19.1 screen

Security Management System @ E

Security Management System

[k w]fe] ) =]=]=]e]o]

[ © Adjuster - Casualty - Level =
i g 23],uszer gas"'a:y teve: r* © M| Entity. Maintenance
- juster - Property - Level =L s
I © Adjuster - Property - Level SHach. o
I © Adjuster - Property - Level =L Alachment
I © Adjuster - Property - Level @ H Banking Info
I @ Administration M| Create
a2 00r M| Delete
_%:‘ LUt. H| Masked
=0 W] Update
a2 22rj )
oo 331 | W | View
I 22 44 rj — M| Create.New
22 aaaa — || Relete
- 22 adi adi — B Petach.From
- &2 Aditya German *5 B | Entity ID. Type

[Fig. 56]
The bank account and routing numbers will appear masked as shown below [Fig. 57]:

DXC Insurance RISKMASTER™ v.19.1 screen

Org. Hierarchy Record (New) / Banking Information (Bank of America) @ E

Banking Information Setup

Basic Information o~
Bank Name * Account #* Banking Status * Effective Start Date
Bank of America FERRR A A Active 02/24/2019
Transit/Routing Number * Account Type * Effective End Date
ks s CA Checking Account 02/25/2019
-
[Fig. 57]

Users with SMS permissions will also be able to Create/ Delete/ Masked/ Update/ Edit/ View the EFT
Information on the following screens:

» People Maintenance » Physician Maintenance
» Employee Maintenance » Medical Staff Maintenance
» Organization » Driver Maintenance
» Patient Tracking
DXC Insurance RISKMASTER™ v.19.1 screen Note:
& > When theE® button is present the
Banking Information accordion [Fig. 58]
Banking Information o on the right-hand pane, the information
displayed in the list for the existing Bank
= Bank of . N
Americat R ERER A CLive info will be masked.
» Transactions can only be executed for

[Fig. 58] entities with associated Active Bank
Accounts only.
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Cloning Module Security Groups

The need for providing the ability to copy a Module Security Group from one Data Source Name (DSN) to
another within the same Security DSN has been addressed in the current release version of Insurance
RISKMASTER.

A new toolbar button Copy Module Group Across DSN has been added on the Security Management
System screen. [Fig. 59]

DXC Insurance RISKMASTER™ v.19.1 screen

Security Management System

El@ Copy Module Group across

@ RISKMASTER SECURITY
© Users
@ DataSources
© OMAG191_MAINDB
© RMA191_ACOFF_CLOUDAut
© RMA191 Ded
© RMACDR191_BES

[Fig. 59]

Selecting this button opens the Copy Module Group Across DSN popup wizard which can be used to copy a
Module Security Group from one DSN to another within the same Security DSN.

DXC Insurance RISKMASTER™ v.19.1 screen

Security Management System

Copy Module Group across DSN

Select Source DSN * Select Destination DSN *

OMAG191_MAINDB Select

}—0 Module Security Groups

Copy Users Overwrite Existing groups in Destination DSN

Copy Module Group —popup wizard Note:
The wizard [Fig. 60] has the following elements: » Respective Module Security Groups are
available under both source &

Command Buttons destination DSNs.

» Accept » Lists of Module Security Groups are

» Cancel displayed for copying when the source
Dropdowns & destination DSNs are selected.

» Select Source DSN » Module Security Groups can be

» Select Destination DSN overwritten if the group's hame exists on
Checkboxes the target DSN.

» Copy Users » Users can also be copied from one DSN

» Overwrite Existing Groups in to the other for the selected Modules

Destination DSN Security Groups.

© 2019. DXC Technology Company. All rights reserved.
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Once the process is completed, the Module Groups Report is generated which shows the names of copied
groups, permissions and users. [Fig. 61]

DXC Insurance RISKMASTER™ v.19.1 screen

Security Management System E

Module Groups Report

Source DSN: OMAG191_MAINDB Destination DSN: RMACDR191_BES

Source Group Destination Group Groups Groups Permissions Groups Users Errorif
Names Names Copied Copied Copied any

Accounting Accounting YES YES YES

[Fig. 61]
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Customer Resolutions

This section of the Release Notes document describes the specific issue
resolutions provided for customers in DXC Insurance RISKMASTER™ v.19.1.

RISKMASTER Launch App Notification

The RISKMASTER Launch App is required for some functionalities in Insurance RISKMASTER like Printing
Checks & Attachments, Mail Merge, Word Merge, for sending emails using Outlook and others. In case, the
RISKMASTER app launcher is not installed at the users’ end, then, an error message will now be displayed
whenever attempts are made to use any of the above-mentioned functionalities.

For e.g.: On the Claim Screen > User Documents > Word Merge Setup and launch any Merge Letter.

Click the “Launch Word” button to proceed. In case the RISKMASTER Launch App is not installed in a
workstation, then, a warning message RISKMASTER Launch App Not Found will be displayed. [Fig. 62]

DXC Insurance RISKMASTER™ v.19.1 Screen

Word Merge Setup

Edit Merge Letter: New Form

Yol Tam TIOW COMPIStE Creatmg s vvord merge wemprats qocument

z_,CIick the "Launch Word" button.

You must have installed RmAppLaunch to Generate Mail Merge Letter.

You must click "Install" button if your web browser prompts you with Application Install - Security warning.
Word will open a new template document. You may insert text; merge fields; ASK or FILLIN fields; etc.
Save and close the document. Do not change the document file name.

Click the "Finish" button in the pop-up to store the template in RISKMASTER Accelerator.

[Fig. 62]

Multilingual CRUD (Create, Read, Update & Delete) Grids

A few menu items in the previous versions of Insurance RISKMASTER could not be made multilingual as they
were not covered in the Localization Setup of the Utility screen. In order to curb this issue, Insurance
RISKMASTER v.19.1 has come up with the CRUD Grid States. The CRUD Grid functionality allows the
customization of the grids that cannot be customized from the Localization Setup and make them
multilingual.

The basic functionality of CRUD Grids is to change the header and label of the selected grids. However, the

fields cannot be removed from the CRUD Grids even if they are not hyperlinked. The CRUD Grids make the
application more fluid.

© 2019. DXC Technology Company. All rights reserved.
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Accessing CRUD Grids

Go to Utilities > Grid State > Global Grid Settings
> Global Grid State (tab)

Select language from the Language Selection
dropdown followed by the required grid in the
Grid Selection field. [Fig. 63]

DXC Insurance RISKMASTER™v.19.1 Screen

Utilities / Grid States

Global Grid Settings
Glohal Grid State Grovp.Grid State

Language Selection:- * Grid Selection:- *

—Select Language-- v - Please Select -- v

[Fig. 63]

The grids covered under CRUD Grids feature are mentioned below:

» Crudadjudication » Crudselfinsured

» Crudaltwaitperiod » Crudmslanguage
» CrudMMSEA » Crudtabledata

» Crudmmseaparty » Crudtokenaddapp
» Crudpowerview » Crudtokenapp

» CrudProceedCalcOption » Crudtpocdata

>

CrudruleEngineConfigGrid

Followed by language selection, select a CRUD Grid from the Grid Selection dropdown (options mentioned
above), to customize its fields by entering the desired text in their corresponding textboxes. [Fig. 64]

DXC Insurance RISKMASTER™v.19.1 Screen

Utilities * Grid States

Global Grid Settings

Language Selection:- + Grid Selection:-

English (Australia) v crudProceedCalcOption v

Column definition:-

Option Name

Option Name

Option Code

Option Code

[Fig. 6l]

To view & verify the changes made in the Global Grid State, switch to the Group Grid State tab, and click
on the Add “+” sign in the top left corner. [Fig 65]

The changes done can be viewed in the Group(s) Configuration popup. [Fig. 65]
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Utilities / Grid States

DXC Insurance RISKMASTER™v.19.1 Screen

Group(s) Configuration

Option Name

Option Name

Option Code

[Fig. 65]

Improved Reserve Validation Script

The Reserve Validation script has been modified and now any changes made to the Reserve Amount will

also be reflected in the Reserve Balance field upon saving the script.

In other words, the Reserve Amount will always be in sync with the Reserve Balance.

Event (2019013973 * 01/22/2019)

DXC Insurance RISKMASTER v.19.1 screen

E J Saved Successfully.

Reserve Type *

I Indemnity

Reserve Sub Type

- Please Select -

H‘ Status *

General Claim (GCcod12019010920)

Assigned Adjuster

Financials/Reserves / Reserve (Indemnity)

BB X

Reserve Balance

USD |($10.00)

Amount

usb

$10.00

© 2019. DXC Technology Company. All rights reserved.

Date Entered * Last Date Entered
O-0Open 03/18/2019 03/18/2019
Status Reason Reason
-- Please Select -
[Fig. 66]
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Important Information

This section includes the Technology Roadmap updates, for DXC Insurance
RISKMASTER™, on issues that currently affect the application. This section
also includes information & suggested actions for using the services of the
newly onboarded third-party business solutions providers.

Technology Roadmap Updates

Ongoing Issues with Google Chrome

DXC Technology has identified a major issue with the Google Chrome Browser (v.73) which affects all
customers of Insurance RISKMASTER from v.16.3 and v.18.3 and restricts their usage of functionalities like
Mail Merge, Print Check (through a local printer) and Print All (in attachments — when printing through a
local printer). Users of Insurance RISKMASTER v.18.1 and v.19.1 remain unaffected by this issue.

A resolution is now available in Chrome's beta version 74.0.3729.40 - 64-Bit (Official Build). The restricted
Insurance RISKMASTER functionalities can still be used without downgrading to Chrome v.72, by using the
beta version of the browser. However, the “metalclick” extension must be installed to use the functions
seamlessly.

The browser's beta version can be uninstalled when Chrome's v.74 is officially available.

Antivirus Warning

DXC Technology advises configuring antivirus programs in such a way that they do not interfere with the
functioning the Insurance RISKMASTER web application. To address the issue of slowness, it is suggested

that appropriate antivirus settings are used for the smooth and lag free use of the Insurance RISKMASTER
application.

Additional Important Information

Features with an asterisk mark (*) involve additional cost/ consulting/
* agreement/ licensing considerations. Please reach out to Insurance RISKMASTER
Support or your Insurance RISKMASTER Sales Representative for more

Select from options below to return to module:

Melissa & RISKMASTER's APl | CHick Here SubroPro by Amali Click Here
Viewpost Click Here PMI Calculator Click Here
Multiple E-mail APls Click Here AWW Calculator Click Here
Cust. Policy Validations Click Here Claims Desktop Click Here
IdP Metadata Click Here Autogenerate SSO Click Here
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DXC Technology: New. But not born yesterday.
.

About DXC Technology

DXC Technology (DXC: NYSE) is the world's leading independent, end-to-end IT services company, serving
nearly 6,000 private and public sector clients from a diverse array of industries across 70 countries. The
company's technology independence, global talent and extensive partner network help clients harness the
power of innovation to thrive on change and guide their digital transformation journeys.

The company was formed on April 1, 2017, by the merger of CSC and the Enterprise Services business of
Hewlett Packard Enterprise. DXC Technology has successfully guided the world’s largest enterprises and
government agencies through successful change cycles. With some 137,000 employees worldwide, the
company’s deep experience gives it a clear and confident vision to help clients navigate the future.

DXC Technology is a Fortune 500 company and represented in the SEP 500 Index. The company works to
create greater value for clients, partners and shareholders, and to present growth opportunities for its
people. DXC Technology is ranked among the world’s best corporate citizens.

DXC Technology’s extensive partner network helps us drive collaboration and leverage technology
independence. The company has established more than 250 industry-leading global Partner Network
relationships, including 15 strategic partners: Amazon Web Services, ATET, Dell EMC, HCL, Hitachi Vantara,
HP, HPE, IBM, Lenovo, Micro Focus, Microsoft, Oracle, PwC, SAP and ServiceNow.

For more details, visit: dxc.technology

About DXC Insurance RISKMASTER™

DXC Insurance RISKMASTER™ is an integrated Claims Administration Platform that consolidates multiple
functions into one cohesive solution to provide accurate and up-to-date business functions using the latest
technology.

This browser-based software provides real-time analytics to help you spot trends and mitigate future losses.
It gives your staff a highly efficient system that simplifies workflows and promotes best practices throughout
your organization. It helps ensure that your claimants receive first-class service, besides providing your
management team with a means to track key metrics to control costs and improve performance.

Thousands of Risk and Claim professionals rely on Insurance RISKMASTER to manage all types of Claims,
making it one of the industry’s leading Claims Management Systems. This active client community ensures
that Insurance RISKMASTER is continually supported and enhanced — keeping your Claims processing
running smoothly today and in the future.

For more details, visit: www.riskmaster.com

Contact
US Mail: DXC Technology
3000 University Drive
Auburn Hills, Michigan 48326
Phone: 1-877-275-3676
Email: risksupp@dxc.com
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